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TRADEMARKS 
 
Windows, MS-DOS, and MS Word are trademarks of Microsoft Corporation. 
 
Novell, Netware are trademarks of Novell, Inc. 
 
Lotus, 1-2-3, and Symphony are trademarks of Lotus Development Corporation. 
 
PC, AT, PC-DOS, OS/2 and Presentation Manager are trademarks of IBM 
Corporation. 
 
UNIX is the trademark of AT&T. 
 
All other brand and product names are trademarks or registered trademarks of their 
respective companies. 
 
The information presented in this publication has been carefully checked for 
reliability; however, no responsibility is assumed for inaccuracies, whereas, 
specification is subjected to change without notice. 
 

WARNING 
 
For the system to operate normally, please make sure JP0 of the mainboard is set as 
below.  Refer to Fig. 4 in this manual for the location JP0. 
 

 
 
If JP0 is opened or shorted to 2-3, no CMOS data can be retained. 
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CHAPTER 1  
 INTRODUCTI
ON 

 
The motherboard is designed to support the latest PCI (Peripheral Component 
Interconnect) local bus standard.  It is developed around the pentium 
microprocessor (P54C) with 64-bit access to data transfer, and integrated with the 
I/O chip (W83877F), Sound System (ESS1868), VGA Controller (SiS 5596), and 
PCI IDE Master/Slave Controller (SiS 5513) to form a high performance and cost-
effective computer system. 
 
 
1.1 GENERAL SPECIFICATION 
 
 Processor 
 

?? Intel Pentium P54C series,  P55C series. 
?? Cyrix 6x86, Cyrix 6x86L; AMD-K5 and AMD-K6 series 64-bit 

microprocessor. 
?? The mainboard can run with following speeds: 
 75, 90, 100, 110, 120, 133, 150, 166, 200 and 233 MHz 

 
 
 Chipset 
 

?? SiS 5596 PCI, Memory and VGA Controller 
?? SiS 5513 PCI System I/O 
?? Winbond W83877F Super I/O Controller 
?? ESS ES1868 Audio-Drive Sound Controller 

 
 
 Cache Size  
 

?? Built in 256KB or 512KB Sychronized Pipelined Burst Mode SRAM 
to achieve the high Pentium system performance. 
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 Main Memory 
 

?? Mainboard can decode the DRAM space up to 512MB, possible 
memory configurations are from combination of 256K*36 to 
16M*36 double side SIMM module (32-bit non-parity 72-pin SIMM 
module also available). 

?? Support both Fast Page Mode and Extended Data Output (EDO) Mode 
DRAM Modules. 

?? Hidden DRAM Refresh for higher system performance. 
 
 
 Graphics Controller 
 

?? Built-in an enhanced 64-bit BITBLT graphics engine with VGA feature 
connector on board. 

?? PCI 2.1 compliance, and PCI multimedia design Rev 1.0 support 
?? Support DCI Drivers and Direct Draw Drivers. 

 
 
 Multi I/O 
 

?? On board Multi-I/O supports two serial, one parallel ports and floppy 
drive controller. 

?? Serial ports are 16550 Fast UART compatible. 
?? Parallel port has EPP and ECP capabilities. 
?? External PS/2 Mouse Cable is provided. 
?? Optional PS/2 keyboard and PS/2 mouse connector is provided. 
?? Optional IrDA or Fast IR is provided. 
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 PCI IDE 
 

?? On board supports PCI Master IDE Controller, two connectors support 
up to four IDE devices such as HDD, CD ROM drive and Tape Back-up 
drives, etc. 

?? PCI Master IDE controller supports PIO Mode 3 and 4 devices, I/O 
data transfer rate can be up to 17Mb/s. 

 
 
 Sound Controller 
 

?? Compatible with all major PC sound standards, including Sound 
Blaster?  Pro, MPU-401 and Windows Sound System? . 

?? Plug-and-Play support for Audio, Joystick, FM Controller, MPU-401. 
?? Wave Audio support sample rates from 4KHz  to 44KHz. 
?? Full-duplex monophonic mode, half-duplex stereo mode. 
?? Optional 3D stereo sound effect supported (for GOI-600D and GOI-

600DW). 
?? Optional wavetable support (for GOI-600DW). 

 
 
 System BIOS 
 

?? Award/AMI BIOS (128KB Flash EPROM). 
 
 
 Slots 
 

?? Four PCI slots 
?? Three ISA slots 
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 Board 
 

?? 4 Layers 
 
 
 Form Factor 
 

?? 220mm (W) x 270mm (L) 
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1.2 MAINBOARD  COMPONENTS 
 

This section gives a brief description of key components on the mainboard. 
Please refer to Fig. 1a and Fig. 1b  for components location. 

 
 

 
 

Fig. 1a Key Components of the Mainboard 
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Fig. 1b Key Components of the Audio Extension Card (Optional) 
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CHAPTER 2   MEMORY 
    

 CONFIGURAT
ION 

 
2.1 SYSTEM MEMORY 
 
 The mainboard lets user add system memory via SIMM sockets on the 

mainboard.  On-board memory is located in two banks: Bank 0 - SIM1 & 
SIM2, and Bank 1 - SIM3 & SIM4. 

 
 Both single sided and double sided DRAM modules are supported.  The 

mainboard can edcode the DRAM space from 8MB up to 512MB. 
 

Bank 0 
(SIM1/SIM2) 

Bank 1 
(SIM3/SIM4) 

Single None 
None Single 
Single Single 
Single Double 
Double Single 
Double None 
None Double 

Double Double 
 

Table 1: Memory Configuration 
 
 Note: Single means single side SIMM. 
  Double means double side SIMM. 
  The type of SIM1/SIM2 must be same. 
  The type of SIM3/SIM4 must be same. 
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 Both 36 bits and 32 bits (non-parity) SIMM are supported, and user can 
install either 4/8/16/32/64/128MB SIMM (72-pin) in each SIMM socket. 
SIMM speed required for best performance depends on the CPU speed, 
which requires 70ns SIMM. 

 
2.2 CACHE MEMORY CONFIGURATION 
 
 256KB or 512KB secondary cache system is built in with Pipeline Burst 

SRAM: 
 
 Cache Tag RAM Location: U7 
 Size of the Tag RAM: 16Kx8 or 32Kx8 
 Synchronous Pipeline Burst SRAM Location: U32, U33 
 

Cache Size Tag RAM 
(U7) 

Data RAM 
U32, U33 

256K 16Kx8 
or 

32Kx32 

512K 32Kx8 64Kx32 

 
Table 2: Secondary Cache Configuration 
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CHAPTER 3   JUMPER 
    

 SETTINGS 
AND 

    
 CONNECTOR
S 

3.1 CPU TYPE 
 
3.1.1 INTEL PENTIUM CPU 
 
 The pentium processors have different operation voltage.  In order to using 

the CPU Voltage correctly, the following is the marking for identify the 
CPU type. 

 
Fig. 2a CPU Description 

(Bottom Side) 
 Description : 
 
 X = Voltage Specification (S or V)  
        S = Standard Voltage (3.4V) 
        V = VRE 3.4 - 3.6V (3.5V) 
 
 Y = Timing Specification (S or M) 
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        S = Standard EDS timings 
        M = Min Valid Delay Spec. 
 
 Z = Dual Processing Support ( S or U) 
        S = Support DP/MP/UP 
        U = Not tested to support DP 
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3.1.2 INTEL PENTIUM w/ MMX?  TECH (P55C) CPU 
 

The Intel Pentium w/ MMX?  Tech (P55C) CPU is offered with dual 
voltage supply - 2.8V for core and 3.3V (I/O) interface.  The following is 
the marking for identify the CPU type.  (The following diagram is provided 
as an example only.  It does not necessarily indicate a valid product 
marking.) 

 

 
Fig. 2b CPU Description 

(Top Side) 
 
 

 I/O Voltage Core Voltage 

Intel Pentium w/ 
MMX?  Tech (P55C) 

3.3V 2.8V 
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3.1.3 AMD-K6 CPU 
 

The AMD-K6 CPU family require dual voltage power for operation.  The 
AMD-K6-PR166 and AMD-K6-PR200 require a voltage of 2.9V for the 
core and 3.3V for the I/O.  The AMD-K6-PR233 require a voltage of 3.2V 
for the core and 3.3V for the I/O.  (The following diagram is provided as an 
example only.  It does not necessarily indicate a valid product marking.) 

 

 
Fig. 2c CPU Description 

(Top Side) 
 
 

Operating Voltage I/O Voltage Core Voltage 

2.9V 3.3V 2.9V 

3.2V 3.3V 3.2V 
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3.1.4 AMD-K5 CPU 
 
 The AMD-K5 family CPU operates on different operation voltage 

depending on the CPU type.  The operating voltage can be known through 
the marking on the surface of the CPU. (The following diagram is provided 
as an example only.  It does not necessarily indicate a valid product 
marking.) 

 

 
Fig. 2d CPU Description 

(Top Side) 
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3.1.5 CYRIX 6x86 CPU 
 
 The Cyrix 6x86 has different nominal voltage depends on different lot.  

Please refer to the CPU marking. 
 

 
Fig. 2e CPU Description 

(Top Side) 
 
 

Marketing Recommended Nominal Voltage 

3.3V or 3.52V 3.52V 

028 3.52V 

016 3.3V 

Blank 3.52V 
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3.1.6 CYRIX 6x86L CPU 
 

The Cyrix 6x86L has different I/O and core voltage.  Please refer to the 
CPU marking. 

 

 
Fig. 2f CPU Description 

(Top Side) 
 
 

 I/O Voltage Core Voltage 

Cyrix 6x86L CPU 3.3V 2.8V 
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3.2 SETTING THE JUMPERS 
 
 The table below summaries the functions and settings of each jumper of the 

motherboard. 
 

Function Jumper Settings 

CPU Voltage 
Selection 

3.3V Single Voltage CPU 
For P54C, P54CT 

JP1: 
JP11: 
JP12: 
S1: 
S2: 
S3: 

short  
open 
open 
short  
short  
short  

 3.5V Single Voltage CPU 
For P54C-VRE, AMD-K5, Cyrix 6x86 

JP1: 
JP11: 
JP12: 
S1: 
S2: 
S3: 

open 
open 
open 
short  
short  
short  

 3.3V (I/O)/2.8V (core) Dual Voltage CPU 
For P55C, Cyrix 6x86L 

JP1: 
JP11: 
JP12: 
S1: 
S2: 
S3: 

shrot 
open 
short  
open 
open 
open 

 3.3V (I/O)/2.9V (core) Dual Voltage CPU 
For AMD-K6-PR166/PR200 

JP1: 
JP11: 
JP12: 
S1: 
S2: 
S3: 

shrot 
short  
open 
open 
open 
open 

 3.3V (I/O)/3.2V (core) Dual Voltage CPU 
For AMD-K6-PR233 

JP1: 
JP11: 
JP12: 
S1: 
S2: 
S3: 

shrot 
open 
open 
open 
open 
open 

To be continued... 
 

Table 3A: Jumper Setting 
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Function Jumper Settings 

CPU Speed 
Selection 

For 75MHz Intel Pentium, AMD-K5-PR75 CPU JP2: 
JP3: 
S4: 
S5: 
S6: 

1-2 short 
1-2 short 
short  
short  
open 

 For 90MHz Intel Pentium, AMD-K5-PR90 and 
AMD-K5-PR120 CPU 

JP2: 
JP3: 
S4: 
S5: 
S6: 

1-2 short 
1-2 short 
short  
open 
open 

 For 100MHz and 233MHz Intel Pentium,  
AMD-K6-PR233, AMD-K5-PR100 and 
AMD-K5-PR150 CPU 

JP2: 
JP3: 
S4: 
S5: 
S6: 

1-2 short 
1-2 short 
open 
short  
open 

 For 100MHz Cyrix 6x86-P120+ CPU JP2: 
JP3: 
S4: 
S5: 
S6: 

1-2 short 
2-3 short 
short  
short  
open 

 For 110MHz Cyrix 6x86-P133+ CPU JP2: 
JP3: 
S4: 
S5: 
S6: 

1-2 short 
2-3 short 
open 
open 
open 

 For 120MHz Intel Pentium and Cyrix 6x86-P150+ CPU JP2: 
JP3: 
S4: 
S5: 
S6: 

1-2 short 
2-3 short 
short  
open 
open 

 For 133MHz Intel Pentium, AMD-K5-PR133 (REV C) 
and Cyrix 6x86-P166+ CPU 

JP2: 
JP3: 
S4: 
S5: 
S6: 

1-2 short 
2-3 short 
open 
short  
open 

To be continued... 

 
Table 3B: Jumper Setting 
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Function Jumper Settings 

CPU Speed Selection For 150MHz Intel Pentium CPU JP2: 
JP3: 
S4: 
S5: 
S6: 

2-3 short 
2-3 short 
short  
open 
open 

 For 166MHz Intel Pentium, AMD-K6-PR166 and 
AMD-K5-PR166 CPU 

JP2: 
JP3: 
S4: 
S5: 
S6: 

2-3 short 
2-3 short 
open 
short  
open 

 For 200MHz Intel Pentium and AMD-K6-PR200 
CPU 

JP2: 
JP3: 
S4: 
S5: 
S6: 

2-3 short 
1-2 short 
open 
short  
open 

On board Sound Chip  Enabled JP13: short  
Selection (Optional) Disabled JP13: open 

Linear Burst Mode Linear Burst Mode JP7: short  
for Cyrix CPU Normal JP7: open 

Clear RTC Normal JP0: 1-2 short 
CMOS Data Clear JP0: 2-3 short 

System ROM 5V Flash EPROM JP5: 2-3 short 
Selection 12V Flash EPROM JP5: 1-2 short 

 

Table 3C: Jumper Setting 
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3.3 CONNECTION THE MOTHERBOARD 
 
 Once the mainboard have been fastened into the system case, the next step 

is to install the audio extension card and to connect the internal cables.  
The internal cables are wire leads with plastic female connectors that attach 
to the connectors.  The mainboard connectors have varying numbers of pins 
and are the points of contact between the mainboard and other parts of the 
computer. 

 
 A description of each connector and its connector pins follows.  See Fig. 

3a for the location of the connectors on the mainboard. 
 
 Note: Before making connectors on the board, make sure that power 

to the system is turned off. 
 
 
3.3.1 JUMPER PRESENTATION 
 

 
 
3.3.2 JUMPER CONVENTION OF THE MOTHERBOARD 
 
 Different colour of jumper caps (mini-jumpers) are used on the board to 

represent different usage of the jumpers: 
 
 Red : CPU Clock setting 
 Black: Other 
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3.3.3 CONNECTORS LOCATION 
 

 
Fig. 3a Connector Location of the mainboard 
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Fig. 3b Connector Location of the Audio Extension Card (Optional) 
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3.4 CONNECTORS OF MAINBOARD 
 
3.4.1 J1 - RESET SWITCH CONNECTOR 
 
 Attach the Reset switch cable to this connector.  The Reset switch restarts 

the system. 
 

 
 
 
3.4.2 J2 - SUSPEND LED CONNECTOR 
 
 J2 is usually connected to a LED on front of the system case.  If the system 

board select is in suspend mode, the LED will be off. 
 

 
 
 

3.4.3 J3 - SMI SWITCH 
 
 J3 is for SMI Break Switch Setting.  When J3 is trigger from OPEN to 

CLOSE and back to OPEN, the system would suspend immediately. 
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3.4.4 J4 - SPEAKER CONNECTOR 
 
 J4 is a four pin connector, which is used to connect with a speaker. 
 
 

 
 
 
3.4.5 J5 - HDD LED CONNECTOR 
 
 J5 is usually connected to a HDD LED on front of the system case.  If the 

HDD is in operation, the indicator lights during operation. 
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3.4.6 J6 - KEYLOCK CONNECTOR 
 
 J6 is a keylock connector that enables and disables the keyboard. 
 
 

 
 
 
3.4.7 J12 - IrDA CONNECTOR 
 
 J12 is the IrDA connector that using the UART2 as interface for IrDA and 

HP SIR. 
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3.4.8 J13 - PANASONIC/MITSUMI CD ROM AUDIO 
 CONNECTOR 
 

J13 is a four pin connector, which is used to connect with the Panasonic or 
Mitsumi CD ROM audio output. 

 

 
 
 
3.4.9 J14 - SONY CD ROM AUDIO CONNECTOR 
 

J14 is a four pin connector, which is used to connect with the Sony CD 
ROM audio output. 

 

 
 



Jumper Settings and Connectors 
  

27

3.4.10 J15 - FLOPPY DRIVE CONTROLLER 
 

J15 is on the right hand side of PCI Slot 1, please refer to Fig. 3a for its 
location.  This Floppy drive controller also supports 2.88M FDD format. 

 
 
3.4.11 J16 - PARALLEL PORT 
 

J16 is on the right hand side of PCI Slot 1, please refer to Fig. 3a for its 
location.  Pin 1 is on the up left hand side. 

 
 
3.4.12 J17 - PRIMARY IDE CONNECTOR 
 

The bootable Hard Disk must connect to this Primary IDE Connector.  J17 
locates right to J15, please refer to Fig. 3a for its location. 

 
 
3.4.13 J18 - SECONDARY IDE CONNECTOR 
 

J18 locates right to J17, the primary IDE connector.  Please refer to Fig. 
3a for its location. 

 
 
3.4.14 J19 - SERIAL PORT 1 (COMA) 
 

Both COMA and B are 16550 fast UART compatible.  J19 is located in 
between the PCI Slot and the SIMM socket, please refer to Fig. 3a for its 
location.  Pin 1 is on the up left hand side. 
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3.4.15 J20 - SERIAL PORT 2 (COMB) 
 

J20 is on the right hand side of J19, please refer to Fig. 3a for its location.  
Pin 1 is on the up left hand side. 

 
 
3.4.16 J21, J22, J24 - AUDIO EXTENSION CARD 
 CONNECTOR 
 

J21, J22, J24 is a 2x20 pins female connector.  Plug in the optional Audio 
Extension Card into this connector, and the video and audio output will give 
from the Audio Extension Card. 

 
 
3.4.17 J28 - EXTENSION PS/2 MOUSE CONNECTOR 
 

J28 is a five-pin connector with polarity key is located left side of the 
power connector J22.  It is connected with the PS/2 mouse connector 
cable to extend the PS/2 mouse connector to the rear of the system case. 
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3.4.18 J29 - POWER SUPPLY CONNECTOR 
 

The power supply connector has two six-pin male header connectors.  Plug 
the dual connectors from the power directly onto the board connector. 

 

Pin Description 

1 Power Good (Orange) 

2 +5 VDC (Red) 

3 +12 VDC (Yellow)  

4 -12 VDC (Blue) 

5 Ground (Black) 

6 Ground (Black) 

7 Ground (Black) 

8 Ground (Black) 

9 -5 VDC (White) 

10 +5 VDC (Red) 

11 +5 VDC (Red) 

12 +5 VDC (Red) 
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3.4.19 J30 - OPTIONAL PS/2 MOUSE CONNECTOR 
 

An optional six-pin female mini DIN connector is located at the rear of the 
mainboard.  Plug the jack on the PS/2 mouse cable into this connector. 

 

 
 
 
 
3.4.20 J31 - OPTIONAL PS/2 KEYBOARD CONNECTOR 
 

An optional six-pin female mini DIN connector is located at the rear of the 
mainboard.  Plug the jack on the PS/2 keyboard cable into this connector. 
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3.4.21 J32 - KEYBOARD CONNECTOR 
 

A standard five-pin female DIN keyboard connector is located at the rear of 
the mainboard.  Plug the jack on the keyboard cable into this connector. 

 

 
 
 
3.4.22 J33 - OPTIONAL FAST IR CONNECTOR 
 

J33 is a five-pin connector, which is used with J12 as fast IR Interface. 
 

 
 
 
3.4.23 J23 - GAME PORT CONNECTOR 
 

J23 locates left to J19, please refer to Fig. 3a for its location.  Connect the 
game port cable to this connector. 
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3.5 CONNECTORS OF THE AUDIO EXTENSION 
 CARD 
 
3.5.1 J1 - SPEAKER OUTPUT 
 
 J1 is a stereo phone Jack connecotr to connect the speaker output. 
 
 
3.5.2 J2 - LINE OUT 
 
 J2 is a stereo phone Jack connector for signal line out from the sound chip. 
 
 
3.5.3 J3 - LINE IN 
 
 J3 is a stereo phone Jack connector for signal line in to the sound chip. 
 
 
3.5.4 J4 - MIC IN 
 
 J4 is a stereo phone Jack connector for mircophone input to the sound 
chip. 
 
 
3.5.5 J5 - VGA CONNECTOR 
 

J5 is a 3 row 15 pins female D-type connector.  It is used to connect to the 
VGA monitor. 
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3.6 GRAPHICAL DESCRIPTIONS OF JUMPER 
 SETTINGS 
 

 
Fig. 4 Jumper Location 
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3.6.1 CPU VOLTAGE SELECTION FOR 2 TRANSISTORS 
 INSTALLED IN Q4 
 
1. For 3.3V Sigle Voltage CPU: P54C, P54CT 
 

 
 
 
2. For 3.5V Single Voltage CPU: P54C-VRE, AMD-K5, Cyrix 6x86 
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3. For 3.3V (I/O)/2.8V (core) Dual Voltage CPU: P55C, Cyrix 6x86L 
 

 
 
 
4. For 3.3V (I/O)/2.9V (core) Dual Voltage CPU: AMD-K6-PR166/PR200 
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5. For 3.3V (I/O)/3.2V (core) Dual Voltage CPU: AMD-K6-PR233 
 

 
 



Jumper Settings and Connectors 
  

37

3.6.2 CPU SPEED 
 
1. For 75MHz Intel Pentium and AMD-K5-PR75 CPU 
 

 
 
 
2. For 90MHz Intel Pentium, AMD-K5-PR90 and AMD-K5-PR120 CPU 
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3. For 100MHz and 233MHz Intel Pentium; AMD-K6-PR233,  
 AMD-K5-PR100 and AMD-K5-PR150 CPU 
 

 
 
 
4. For 100MHz Cyrix 6x86-P120+ CPU 
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5. For 110MHz Cyrix 6x86-P133+ CPU 
 

 
 
 
6. For 120MHz Intel Pentium and Cyrix 6x86-P150+ CPU 
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7. For 133MHz Intel Pentium, AMD-K5-PR133 (REV C) and 
 Cyrix 6x86-P166+ CPU 
 

 
 
 
8. For 150MHz Intel Pentium CPU 
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9. For 166MHz Intel Pentium, AMD-K6-PR166 and AMD-K5-PR166 CPU 
 

 
 
 
10. For 200MHz Intel Pentium and AMD-K6-PR200 CPU 
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3.6.3 JP13 - ON BOARD SOUND CHIP SELECTION 
 
1. Enable on board Sound Chip 
 

 
 
 
2. Disable on board Sound Chip 
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3.6.4 JP7 - LINEAR BURST MODE FOR CYRIX CPU 
 

If Cyrix CPU is installed, JP7 have to shorted to select for Linear Burst 
Mode, and the option “Linear Burst” should be enabled in BIOS. 

 
1. For Cyrix or IBM CPU: 
 

 
 
 
2. For non-Cyrix CPU: 
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3.6.5 JP0 - DISCHARGE CMOS RAM 
 

JP0 is used to clear the content of the CMOS Data in the Real Time Clock 
Chip. 

 
1. Normal Mode 
 

 
 
 
2. Reset Content of RTC 
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3.6.6 JP5 - VOLTAGE SELECT FOR SYSTEM ROM 
 
1. 5V Flash EPROM as system ROM 
 

 
 
 
2. 12V Flash EPROM as system ROM 
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CHAPTER 4   SOFTWARE 
    

 INSTALLATIO
N 

 
In order to let the system board to work efficiently, a series of drivers have to 
installed according to the operating system used.  The drivers are distributed by CD-
ROM or by diskette.  For CD-ROM version, users have to go through the 
REDME.TXT file on the CD-ROM root directory before installation. (Caution: 
For Windows 95 user, it is very important to follow the procedures described 
in the \DRIVERS\IDE\WIN95\REDADME.TXT.  To install the IDE driver.) 
 
For diskette version, please refer to the following section: 
 
4.1 PCI IDE DRIVER INSTALLATION 
 

Please refer to the README.TXT file in PCI IDE Driver Diskette for 
detail installation procedures to be used in various kind of operating 
system (DOS, Windows 3.1, Windows NT, OS/2 2.XX, Novel 3.1X/4.0X). 

 
 
4.2 PCI VGA DRIVER INSTALLATION 
 

(1) Set VGA Share Memory Size to “0.5MB”, “1MB”, “1.5MB” or 
“2MB” in BIOS Setup to configure the video memory size shared 
by the VGA controller. 

 
(2) Install the PCI VGA Device Driver 

Please refer to the DISK.TXT file in PCI VGA Utility Disk - DOS 
Application, for detail installation procedures to be used in varous 
kind of operating system (DOS, Windows 95, Windows NT, OS/2 
2.XX). 
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4.3 SOUND DRIVER INSTALLATION 
 

Please refer to the README.TXT file in the different directories on the 
Sound Driver Diskette for installation of the sound card driver according to 
the operating system used. 

 
 
4.4 THE AUDIORACK32 FOR WIN95 
 
4.4.1 INTRODUCTION 
 

The AudioRack32 enables you to take advantage of your computer's audio 
capabilities with all of the controls conveniently in one compact space. 
You can play audio CDs, wave files (in .WAV and .AUD formats), and MIDI 
files (in .MID and .RMI formats). With the multi-source Audio Mixer, you 
can blend these sources with line-in and microphone sources any way you 
choose. Add tone control and spatialization to your computer with the 3-
D/Tone Controller. You can then record your creations as wave files and 
edit them with the Audio Recorder. 

 
The AudioRack32 has six main parts: 

 
?? Command Center— customizes the appearance of the AudioRack32.  
?? 3-D/Tone Controller— adds 3-D stereo and tone controls to the 

AudioRack32. 
?? Audio Mixer— controls the volume and balance of the AudioRack32 

devices. 
?? Digital Audio Player— plays and records files in the .WAV format.  
?? MIDI Player— enables you to play MIDI files.  
?? Compact Disk Player— enables you to play audio CDs on a CD-ROM 

drive.  
 

In addition, the AudioRack32 has a miniature mode enabling you to control 
the AudioRack32 while using minimal screen space.  

 
The Audio Recorder is a separate application from the AudioRack32. It 
can be used to add effects and edit files recorded with the Digital Audio 
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Player or by the Audio Recorder itself. The Audio Recorder can be 
launched from the AudioRack32’s Digital Audio Player or on its own. 

 
 
4.4.1.1 INSTALLING THE AudioRack32 
 

 
 

Placing the multimedia CD-ROM Driver in the CD-ROM Drive or 
AudioRack32 disk in a floppy drive, click Start on the taskbar and choose 
Run from the popup menu. 

 
In the Run dialog box, type the letter of the drive and setup (for example, 
D:\APPS\AUDIO\ARCK32\SETUP), then click OK.  The first 
AudioRack32 Setup dialog box appears. 

 

 
 

Note the instructions, then click Next to proceed or Cancel to leave Setup. 
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Next the Choose Destination Location dialog box appears. 
 
 

 
 
 
Click Next to install the AudioRack32 in the default directory or Browse to 
choose a different directory. Click on Cancel to leave the Setup program or Back 
to return to the Welcome dialog box.  
 
If you wish to install the AudioRack32 in a directory other than the default 
directory, enter the directory path in the Browse dialog box. 
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When you are done click OK or Cancel to return to the Choose Destination 
Location dialog box. 
 
If the directory you designate doesn’t exist, you will be asked to confirm your 
selection. Click Yes to proceed or No to go back and enter a new destination 
directory. 
 

 
 
Once you have chosen the default directory or entered a directory of your own 
choosing, the Setup program will install AudioRack32. 
 
Before completing installation of the AudioRack32, you will be given the option to 
view the README file before exiting the setup program 
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Click Yes to view the README file now or No to skip the README file and finish 
the installation. 
 
Upon successful completion of the AudioRack32 installation, the following 
message will be displayed. 
 

 
 
 
4.4.1.2 UNINSTALLING THE AudioRack32 
 

To remove the AudioRack32 from your system, start by clicking on (but 
not releasing) Start on the taskbar. Move the cursor to Settings and select 
Control Panel. From the Control Panel choose Add/Remove Programs. 
Select AudioRack 2.0 from the list and click Add/Remove. After you 
confirm your decision, the AudioRack32 will be uninstalled. 
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4.4.1.3 STARTING THE AudioRack32 
 

 
 

Begin by either clicking or pressing (but not releasing) Start on the 
taskbar. Move the cursor to Programs and click or wait a moment for the 
continuation menu to open. When it opens, select the AudioRack32 folder 
command and click or wait a moment for the next menu to open. Finally, 
select the AudioRack32 logo command and click or release the mouse 
button to start the AudioRack32. 

 

 
 

Note: If you don’t have a CD-ROM drive or the CD audio driver is not installed, 
the Compact Disk Player portion of the AudioRack32 will not be 
displayed.  If your hardware doesn’t include the Spatializer®  (GOI-
600D/DW) the 3-D/Tone Controller portion of the AudioRack32 may be 
displayed, but will not affect the audio of your computer. 
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The other application available in the AudioRack32 folder is the Audio Recorder. 
Follow the steps for starting the AudioRack32, except click Audio Recorder in 
the last continuation menu to start the Audio Recorder. 
 

 
 
 
4.4.2 THE COMMAND CENTER 
 
 

 
 
 
4.4.2.1 INTRODUCTION 
 

The Command Center controls which parts of the AudioRack32 are 
displayed. You can display or hide any part of the AudioRack32 you 
choose, customizing its appearance to suit your needs or desires. It also 
displays information on the status of the different audio components. 

 
 
4.4.2.2 THE COMMAND CENTER CONTROLS 
 

  closes the AudioRack32 window.   displays or hides th 3-D/Tone Controller. 
 

  Enables the Miniature mode,   displays or hides the Digital Audio Player. 
 minimizing the AudioRack32. 

 

  accesses On-line Help.   displays or hides the Compact Disk Player
  

  displays/hides the Mixer.   displays or hides the MIDI Player 
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4.4.2.3 THE COMMAND CENTER DISPLAY 
 

The Command Center display shows information about the status of the 
different AudioRack32 components. The display is divided into three rows 
(one each for the Digital Audio Player, the MIDI Player, and the Compact 
Disk Player) and five columns (showing a track or file counter, a 
component icon, the transport state, the track or file name, and a time 
index). The MIDI Player’s row has an additional column to show which 
MIDI patch set is in use. 

 

 
 counter icon state file name time index 
 

Counter: shows you which track or file in the playlist the component is 
playing. 

 
Component Icon: is displayed when the associated component is shown 
and is not displayed when the component is hidden. 

 
Transport State Indicator: shows the state of a component. It indicates 
when the component is playing, paused, has the Auto Repeat enabled, or in 
the case of the Digital Audio Player, is recording. 

 
Track or File Name Display: shows the name of the current track or file 
in the playlist. 

 
Time Index: displays the amount of time elapsed for the track or file in 
hours, minutes, seconds, and tenths of a second. 

 
The Command Center has an indicator to show when you are listening to 
ESFM. When the ESFM light between the transport state and the file name 
is lit in the MIDI Player’s row, the MIDI Player is using ESFM synthesis. 
ESFM performs superior-quality music synthesis compared to that of 
traditional FM. 
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4.4.3 THE MINIATURE MODE 
 

 
 
 
4.4.3.1 INTRODUCTION 
 

The Miniature mode is designed to give you full control of the 
AudioRack32 while using a minimum of space.  You are able to effectively 
use the AudioRack32 and still have enough room on your desktop  to run 
other applications.  In the Miniature mode, you can play, pause, stop, and  
control the master volume of the AudioRack32. 

 
 
4.4.3.2 THE MINIATURE MODE CONTROLS 
 

 
stops currently playing tracks or files of 
active components. 

 

 
plays currently loaded tracks or files of 
active components. 

 

 

 
pauses currently playing tracks or files of 
active components. 

 

 
 
 

 

calls a popup menu where you can restore 
the AudioRack32, invoke the Always on 
Top command, select active components 
(DAT, MIDI, or CD), or exit the 
AudioRack32.  The Stop, Pause, and Play 
buttons affect components that are currently 
active. 

 

controls the master volume.  
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4.4.3.3 USING THE MINIATURE MODE 
 

Clicking Stealth puts the AudioRack32 display into the Miniature mode.  
Any audio component (the Digital Audio Player, MIDI Player, or Compact 
Disk Player) that is currently playing tracks or files remains active when 
you enter the Miniature mode.  You can also activate or deactivate audio 
components by clicking the Pop-Up Menu button and selecting or 
deselecting them from the list; however, if a unit has no tracks or files 
loaded, it won’t be able to play anything.  To return to the AudioRack32 
window, double click on the Miniature mode display or select Restore 
from the pop-up menu. 
 
There is a second way to enter the Miniature mode: When under the 
Microsoft Windows95 system shell, double-clicking on a playlist icon 
lauches the AudioRack32 in the Miniature mode. 
 

Note: When the AudioRack32 enter the Miniature mode with the 
Audio Mixer in Record mode, a system warning message be 
displayed: “Volume Playback Mixer is off. Volume control is 
disabled.”  To retain control of the master volume, be sure the 
Audio Mixer is in Playback mode before switching to Miniature 
mode. 

 
 
4.4.4 THE 3-D/TONE CONTROLLER 
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4.4.4.1 INTRODUCTION 
 

For GOI-600D/DW Audio Extension Card, Spatializer hardware (ES938) is 
provided that you can enjoy 3-D stereo effects and tone control. The 3-
D/Tone Controller has the Spatial Control and the Tone Controls. By 
turning on the Spatial Control, any sound played through the AudioRack32 
is transmitted in a wider arc, creating an atmosphere of a resonant sound 
environment rather than audio issuing from a two dimensional plane. The 
Tone Controls are used to boost or reduce the low end and high end of the 
sound spectrum respectively giving you fuller sound. 

 
 
4.4.4.2 THE 3-D/TONE CONTROLLER CONTROLS 
 

     

      
 
 
4.4.4.3 THE 3-D/TONE CONTROLLER DISPLAY 
 

 
 

              
 
 
 
 
 
4.4.4.4 USING THE SPATIAL CONTROL 

Controls the amount of 
spatialization from off 
to minimum level to 
mid level to maximum 
level. 

Shows the amount of spatialization by the number of speakers that 
are illuminated. If you set the Spatial Control to max, all the 
speakers are blinking. 

 

Enables and disables the Bass or 
Trebble Control. There is one 
Toggle button for each. 

Shows the amount of boosting or reduction of the Bass or Treble. 
The higher up the column past the mid point the light is lit, the more 
boosting of the given tone control; Bass or Treble. The farther 
below the mid point the light is, the greater the reduction of the 
given tone control; Bass or Treble 3-D/Tone. 

Controls the amount of boosting or 
reduction of the Bass or Treble. 
There is one slider for each. 
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It has four settings to converts sound from the AudioRack32 into a 3-D 
sound: 

 
 Max: provides greatest effect, works best with games. 
 Mid: works best with most audio CDs and music (Default setting). 
 Min: works best with some audio CDs. 
 Off: no spatialization, normal stereo. 

 
There are two ways to set the Spatial Control. First, you may click on the 
label of the setting you wish to set the control to.  The second way is to 
click on the dial at the point at which you want the dial to be set. 

 
 
4.4.4.5 USING THE TONE CONTROLS  
 

Tone Controls, Bass and Treble. You can turn these controls on and off by 
clicking on their toggle switches labeled with Bass or Treble. Then use the 
slider located to the right of the label to control the amount of Bass or 
Treble.  Once you have selected one of the sliders you can use the up and 
down arrow keys on your keyboard to increase or decrease the amount of 
Bass or Treble. 

 
 
4.4.5 THE AUDIO MIXER 
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4.4.5.1 INTRODUCTION 
 

The Audio Mixer is really two devices in one. These are represented by the 
two modes: Record mode and Playback mode. When in Record mode, the 
Audio Mixer regulates the volume and balance of audio signals coming into 
your recorder. When in Playback mode, the Audio Mixer regulates the 
volume and balance of outgoing audio.  You can toggle between these two 
modes by alternately clicking Playback and Record on the left side of the 
Audio Mixer. 

 
 
4.4.5.2 THE AUDIO MIXER CONTROLS 
 

The number of sources available to the Audio Mixer may vary depending on 
the hardware setup of your computer. For instance, unless you have a CD-
ROM drive, you won’t have a CD source available. Common sources that 
your computer may have are: 

 
Line: sound from an audio device outside your computer, hooked up to 

the Line-In jack. 
Wave: sound from the Digital Audio Player. 
Mic: sound from a microphone hooked up to the Mic jack. 
CD: sound from the Compact Disk Player. 
MIDI: sound from the MIDI Player. 
Aux: sound from an additional line-in determined by the hardware 

manufacturer. Check your hardware manual for how this source is 
used. 

Master: controls the volume of all the channels mixed together before it 
goes to your speakers or the recorder. 
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Each source has a balance slider. However, if your hardware doesn't 
support stereo, you cannot affect the balance.  Selecting a balance slider 
and using the left and right arrow keys on your keyboard enables you to 
change the balance as well. Before adjusting the balance on a wave file, be 
sure the file is in stereo, not mono. 
 
Each source also has a Mute button with the name of the source on it. Click 
the button to toggle the mute on or off. When the green light is on, the 
channel is active; when the green light is blackened, no sound will come out 
of that channel. It’s a good idea to check that your Mute buttons are lit if 
you aren't getting the sound you expect. 
 

 
 

Because your Playback mode and Record mode settings can be different, it 
can be useful to click Monitor while you are recording. This enables you 
to hear your recording as the Digital Audio Player “hears” it. Remember 
that Monitor will be disabled while you are in Playback mode. You must 
be in Record mode to turn the monitor on or off. 

 



Chapter 4 
 
62

4.4.5.3 MULTIPLEXER 
 

In Record mode, the AudioRack32 mixer will behave like a multiplexer 
with some hardware setups. What makes a multiplexer different from a 
mixer is that on a multiplexer only one recording source is available at any 
one time. All other sources are muted. So if you select the microphone 
source by clicking on the mute button labeled Mic, all other sources shown 
will be muted. 

 
There are four ways to tell if you have a multiplexer in Record mode 
instead of a mixer. They are: 

 
1. Only one mute button is lit at any one time. 
2. The monitor button is disabled. 
3. Control of the Master volume is unavailable. 
4. There is a source labeled Mixer. 

 
In all other ways a multiplexer looks and behaves as a mixer. 
 

Note: The multiplexer exists only in Record mode, not in Playback mode. 

 
 
4.4.5.4 RECORDING FROM MIXER SOURCE 
 

Multiplexers will have a source labeled Mixer. You can use this source to 
mix audio for recording. The Mixer source uses the mixer in the Playback 
mode as a source for audio.  To mix audio for recording, select the Mixer 
source in Record mode. Next, select Playback mode. Select from the 
sources available the ones you want to record and adjust their balance and 
volume. For example, if you want to sing with a CD and record it, make 
sure that the mute buttons for Mic and CD are lit and adjust the balance and 
volume of these two sources to your liking. Return to the Record mode and 
you can use the Mixer source as a Master volume and balance control 
adjusting the volume and balance of the mixed audio from the mixer in the 
Playback mode. Now you are ready to start recording. Click on the record 
button and play the devices you wish to record from.  
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4.4.6 THE DIGITAL AUDIO PLAYER 
 
 

 
 
 
4.4.6.1 INTRODUCTION 
 

The Digital Audio Player enables you to play, record, and compress sound 
as .WAV files. In addition, you can play .AUD files. The .WAV files use 
PCM, which is the Windows?  audio file format. The .AUD format uses 
ESPCM?  compression to produce an audio file. Files are written directly 
to your hard disk as you record, enabling you to record very large files. 
Your only limitation is the amount of free space on your hard disk. The 
voice activation feature is useful for recording any kind of intermittent 
audio. The Digital Audio Player provides a choice of linear PCM (8 or 16 
bit) recording. Note that you have additional options using the Audio 
Recorder, which is invoked by the Edit button. 

 
 
4.4.6.2 SYSTEM REQUIREMENTS 
 

If you wish to use 16-bit stereo at 44.1 kHz for recording or playback, we 
recommend that your computer have the following capabilities: 

 
?? A 486DX processor with an internal clock speed of 50 MHz or more 
?? 8 megabytes or more of RAM 
?? An average hard disk access time of 15 milliseconds or less 

 
Computers without these capabilities may lose data if you attempt a 16-bit 
stereo playback or recording at 44.1 kHz. 

 



Chapter 4 
 
64

4.4.6.3 THE DIGITAL AUDIO PLAYER  
 

 starts recording to your hard disk.  goes to the end of the wave file or to the 
    next file in the current playlist. 
 

 plays the wave file currently loaded.  enables or disables the Auto Repeat. 
 

 activates or deactivates the Pause.  Opens the Audio Recorder window. 
 

 stops the file currently playing.  opens the Set Playlist dialog box. 
 

 goes back one second in the wave file.  starts a new file by opening the New Options  
   dialog box. 
 

 goes forward one second in the  brings up the Open file dailog box in order  
 wave file.  to load a file into the Digital Audio Player. 
 

 goes to the begining of the wave file   saves an audio file. 
  or to the next file in the current playlist. 
 
 
4.4.6.4 THE DIGITAL AUDIO PLAYER DISPLAY 
 

 

 

The Level Meter displays the output from the left 
(top) and right (bottom) channels when a wave file is 
played. 
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By clicking on the image of the tape deck, you can display information 
about the file currently loaded in the Digital Audio Player. The display tells 
you the file name, size, number of bits per sample, sample rate, and 
whether the file was recorded in stereo or mono. Click again to return to 
the image of the tape deck. 

 
 
4.4.6.5 PLAYING A WAVE FILE 
 

First click Open to bring up the Open file dialog box. 
 

 
 

Select the directory and the .WAV or .AUD file you wish to play and click 
Open. Now you can play the file by clicking Play. 
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4.4.6.6 RECORDING A WAVE FILE 
 

Start by clicking New to open the New Options dialog box. 
 

 
 

You now have several choices to make: the sampling rate, the option for 
stereo, the format, recording synchronization, and vo ice activation.  

 
Choose the format first. You have a choice of PCM 16 bit and PCM 8 bit. 
With PCM, the more bits you use, the higher the quality of the recording; 
however, if you use more bits, you may drastically increase the amount of 
disk space the file requires for storage. The format you choose also 
determines the sampling rates available to you.  
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Next, choose a sampling rate from 5.5 kHz to 44.1 kHz. As in the case of bits, the 
more samples you take per second, the more disk space your file requires. 
 
Finally, if your hardware supports stereo, you can opt to record the file in stereo. 
Remember that choosing stereo doubles the amount of disk space your file 
requires. 
 
Recording synchronization starts the selected AudioRack32 component playing 
automatically when you click Record on the Digital Audio Player. Of course, a file, 
playlist, or CD must be loaded in the component selected. To use recording 
synchronization, select the Yes, Recording Synchronize  check box and select the 
components you want to synchronize: MIDI Player or Compact Disk Player. 
 

Note: If you don’t have a CD-ROM drive, you don’t have the option of 
synchronizing that component. 

 
Voice activation pauses the recording when there is no input from the recording 
source or sources. To use voice activation, select the Pause Recording After 
check box, then enter a number from 1 to 9 in the Seconds of Silence box. The 
recording pauses only after a number of seconds of no input equal to the number 
entered in the Seconds of Silence box. Recording resumes when input from the 
recording source or sources resumes. 
 
When you are finished click, OK. 
 
Next, put the Audio Mixer into Record mode to see that the sources you wish to 
record are active. 
 
You are now ready to record. Click Record and start any audio devices you are 
recording from. Remember, if you are using recording synchronization, 
synchronized devices are started automatically. 
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4.4.6.7 SAVING A WAVE FILE 
 

When you are satisfied with your recording, click Save to open the Save As 
dialog box. 

 
Enter the file name, then choose the directory under which you wish to 
save the file. When you are done, click Save. 

 
 
4.4.6.8 EDITING A WAVE FILE 
 

Clicking Edit opens the Audio Recorder window. 
 
 
4.4.6.9 PLAYING A WAVE FILE PLAYLIST 
 

Start by clicking Playlist to open the Set Playlist dialog box. Next, click 
Open to choose the playlist you wish to listen to. Select the directory and 
drive where the playlist file is located. Once you find the file, either click 
the file once and then click Open or just double-click the file. Wave file 
playlist files have the .WVL extension. When you open the playlist file, 
return to the AudioRack32 window by clicking OK. Click Play to start the 
playlist. 

 
 
4.4.6.10 CUSTOMIZING A WAVE FILE PLAYLIST 
 

Begin by clicking Playlist on the Digital Audio Player to open the Set 
Playlist dialog box. If you want to modify an existing playlist, be sure it is 
loaded first. 
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There are two ways you can move files into the Playlist box: 
 
 • Highlight the file and click Add. 
 • Double-click the file. 
 
Click Add All if you want to copy all the files to the playlist. 
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There are two ways to remove files from the Playlist box: 
 

 • Highlight the file and click Remove. 
 • Double-click the file. 

 
Click Clear if you want to remove all files from the Playlist box. 

 
To change the order in which the files appear, you can click and drag a file, 
dropping it into its new position. There are times when you might not 
remember how a file sounds from its name. Select the file and click 
Preview to hear what it sounds like. The file currently being previewed is 
displayed directly beneath the Preview button. 

 
When you are done choosing which files are to be in your playlist and 
determining the order in which they appear, click Save. If you want to give 
your playlist a new name, click Save As  to open the Save As dialog box. 
Enter a name and directory to save the playlist file under and click Save. 

 
 
4.4.6.11 SETTING THE DEFAULT WAVE FILE PLAYLIST 
 

When you have created a wave file playlist that you like, you may want to 
have that playlist file loaded automatically every time you start the 
AudioRack32. The Used as Default List check box in the Set Playlist 
dialog box fulfills this function. The Used as Default check box is selected 
automatically when you call up the Set Playlist dialog box. The default 
playlist file is chosen when you click OK to exit the Set Playlist dialog box 
with the following two conditions: 
 
1. The Used as Default List check box is selected. 
2. The current playlist is a previously saved playlist file. 
 
If the Used as Default List check box is not selected when you click OK, 
there will be no default playlist file. Nothing will be loaded into the Digital 
Audio Player when you next start the AudioRack32. 
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If the current playlist has not been saved, you will be prompted to save the 
current playlist as a wave file playlist file before trying to return to the 
AudioRack32. In other words, you have started from scratch and created a 
brand new playlist file, which as of yet has not been saved and therefore has 
no file name associated with it. When the Used as Default check box is 
selected,you will not be allowed to return to the AudioRack32 until you 
give the playlist file a name. 

 
Remember to save any changes you want to make to a playlist file before 
you return to the AudioRack32. Only the last saved version of the default 
playlist file will be loaded into the Digital Audio Player. 

 
Once the two conditions listed above have been met, the AudioRack32 will 
automatically load the default playlist file into the Digital Audio Player 
every time you start the AudioRack32 until you choose a new playlist file 
to be the default playlist. 

 
 
4.4.7 THE MIDI PLAYER 
 
 

 
 
 
4.4.7.1 INTRODUCTION 
 

The MIDI Player enables you to play MIDI files with the  .MID or .RMI file 
extensions.  These MIDI (Musical Instrument Digital Interface) files can be 
produced by sequencer programs and then played back using the MIDI 
Player. 
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4.4.7.2 THE MIDI PLAYER CONTROLS 
 

 plays the MIDI file currently loaded.  goes back one file in the playlist. 
 

 activates or deactivates the Pause.  goes forward one file in the playlist. 
 

 stops the file currently playing.  enables or disables the Auto Repeat. 
 

 goes back one second in the MIDI file.  Opens the Set Playlist dialog box.  
 

 goes forward one second in the MIDI file.  
 
 
4.4.7.3 THE MIDI PLAYER DISPLAY 
 

 
 

By clicking on the image of the floppy drive, you can display the length and 
name of the current MIDI file in the playlist. Click the display to return to 
the image of the floppy drive. 

 

  
playlist button is lit, the MIDI Player is using ESFM synthesis. ESFM 
performs superior-quality music synthesis compared to that of traditional 
FM, ESFM is invoked automatically under Windows when you have 
properly installed hardware equipped with ESFM synthesis capability. 

 

The MIDI player has an indicator to show when you are 
listening to ESFM.  When the ESFM light to the left of the           
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4.4.7.4 PLAYING A MIDI FILE 
 

The MIDI Player plays files with the .MID and .RMI extensions. To play 
one or more of these files, first click Playlist. This opens the Set Playlist 
dialog box. 
 

 
 

Choose the directory containing the file or files you wish to play. Then 
highlight those files and click Add to copy them to your playlist. You can 
double-click a file as well to add it to the playlist. When you are done, 
click OK. 
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Now you are ready to play a MIDI file. Click the Play button to start the 
file. The player continues to play this file to the end and then moves on to 
the next file in the playlist until there are no more files to play. You may 
click the Stop button to halt play. Clicking the Pause button enables you to 
stop and resume playing anywhere in a file. Clicking the Auto Repeat 
button causes the MIDI Player to repeatedly play an entire playlist.  
 
 

4.4.7.5 PLAYING A MIDI FILE PLAYLIST 
 

The first step is to click the Set Playlist button. Click Open in the Set 
Playlist dialog box to bring up the Open dialog box. 

 

 
 

From the Open dialog box, you can load a previously saved playlist of MIDI 
files (MIDI playlist files have the .MDL extension) into the Set Playlist 
dialog box either by selecting the files or entering the file names and 
clicking Open or by double-clicking the playlist files. You can then edit 
the list or return to the MIDI Player and press the Play button to play the 
files. 
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4.4.7.6 CUSTOMIZING A MIDI FILE PLAYLIST 
 

You can add, delete, and arrange MIDI files you wish to play in any manner 
you desire. If you want to modify an existing playlist, you must load it first 
as previously described. 

 
There are two ways you can move a MIDI file into the Playlist box: 

 
?? Highlight the file and click Add. 
?? Double-click the file. 

 
Click Add All if you want to copy all the MIDI files to the playlist. 
 
There are two ways to remove a MIDI file from the Playlist box: 

 
?? Highlight the file and click Remove. 
?? Double-click the file. 

 
Click Clear if you want to remove all MIDI files from the Playlist box. 

 
To change the order in which the files appear, you can click and drag a file, 
dropping it into its new position. There are times when you might not 
remember how a file sounds from its name. Select the file and click 
Preview to hear what it sounds like. The file currently being previewed is 
displayed directly beneath the Preview button. 
 
When you are done choosing which files are to be in your playlist and 
determining the order in which they appear, click Save. If you want to give 
your playlist a new name, click Save As  to open the Save As dialog box. 
Enter a name and directory to save the playlist file under and click Save. 
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4.4.7.7 SETTING THE DEFAULT MIDI FILE PLAYLIST 
 

When you have created a MIDI file playlist that you like, you may want to 
have that playlist file loaded automatically every time you start the 
AudioRack32. The Used as Default List check box in the Set Playlist 
dialog box fulfills this function. The Used as Default check box is selected 
automatically when you call up the Set Playlist dialog box. The default 
playlist file is chosen when you click OK to exit the Set Playlist dialog box 
with the following two conditions: 
 
1. The Used as Default List check box is selected. 
2. The current playlist is a previously saved playlist file. 

 
If the Used as Default List check box is not selected when you click OK, 
there will be no default playlist file. Nothing will be loaded into the MIDI 
Player when you next start the AudioRack32. 

 
If the current playlist has not been saved, you will be prompted to save the 
current playlist as a MIDI file playlist file before trying to return to the 
AudioRack32. In other words, you have started from scratch and created a 
brand new playlist file, which as of yet has not been saved and therefore has 
no file name associated with it. When the Used as Default check box is 
selected,you will not be allowed to return to the AudioRack32 until you 
give the playlist file a name. 
 
Remember to save any changes you want to make to a playlist file before 
you return to the AudioRack32. Only the last saved version of the default 
playlist file will be loaded into the MIDI Player. 

 
Once the two conditions listed above have been met, the AudioRack32 will 
automatically load the default playlist file into the MIDI Player every time 
you start the AudioRack32 until you choose a new playlist file to be the 
default playlist. 
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4.4.8 THE COMPACT DISK PLAYER 
 

 
 
 
4.4.8.1 INTRODUCTION 
 

If you have a CD-ROM drive, you can play audio CDs.  The Compact Disk 
Player uses intelligent CD playlist management. It remembers the last 
playlist you used with each CD and loads that playlist automatically 
whenever you insert that CD. 

 
 
4.4.8.2 THE COMPACT DISK PLAYER CONTROLS 
 

 plays the current track in the playlist.  goes back one track in the playlist. 
 

 activates or deactivates the Pause.  goes forward one track in the playlist. 
 

 stops the track currently playing.   opens the Set Playlist dialog box.  
 

 forward five seconds to the current  ejects the CD from the CD-ROM drive. 
 track. 
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4.4.8.3 PLAYING COMPACT DISKS 
 

Insert the CD you wish to play in the CD-ROM drive, then click the Play 
button. Clicking the Stop button resets the current track to its beginning 
and stops play. To halt the Compact Disk Player at a specific point on a 
track, click the Pause button. Click the Auto Repeat button to have the 
current playlist played continuously. When you wish to play a different CD, 
first click the Stop button, then the Eject button, and your CD is ejected 
from the CD-ROM drive. Then load the desired CD and click the Play 
button. 

 
 
4.4.8.4 PLAYING A COMPACT DISK PLAYLIST 
 

If you want to play a previously saved playlist from one of your CDs, you 
must load it by clicking Playlist. This opens the Set Playlist dialog box.   
Enter the name of or click the playlist file you wish to play. CD playlist 
files have the .CDL extension. Click Open when you have selected the 
playlist file. This returns you to the Set Playlist dialog box. Clicking OK 
returns you to the AudioRack32 window where you can just click the Play 
button to start the Compact Disk Player. 
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4.4.8.5 CUSTOMIZING A COMPACT DISK PLAYLIST 
 

To customize your own playlist for a CD, click Playlist. This opens the Set 
Playlist dialog box. 

 

 
 

Click in the CD Title text box and enter the name of the CD.  To change the 
name of a track, select a track from the tracklist, then enter a new name in 
the Track Name text box. Click Update Name or press Return to enter the 
new name after you type it. 
 
There are three ways you can move a track into the Playlist box: 
 
?? Select the track and click Add. 
?? Double-click on the track. 
?? Drag a track from the tracklist and drop it into the playlist. 

 
Click Add All if you want to copy all the tracks to the playlist. 
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There are three ways to remove a track from the Playlist box: 
 
?? Select the track and click Remove. 
?? Double-click on the track. 
?? Drag a track from the playlist and drop it into the tracklist. 

 
Click Clear if you want to remove all tracks from the Playlist box. 

 
To change the order in which the tracks appear, you can click and drag a 
track, dropping it into a new position. There are times when you might not 
remember how a track sounds from its name. Select the track and click 
Play Track to hear what it sounds like. The track currently being previewed 
is displayed directly above the Play Track button. 

 
Choose the Shuffle option if you wish the Compact Disk Player to play the 
tracks on your playlist in random order. When you are done, click OK. 

 
After customizing a playlist, save it by clicking Save. To give the playlist 
file a different name from its current one, click Save As  to open the Save 
As dialog box. 

 
You can name your playlist with the .CDL extension by typing in the file 
name and clicking Save. The AudioRack32’s intelligent CD management 
will load that playlist the next time you load the CD in your CD-ROM drive 
unless you save another playlist for that CD. The Compact Disk Player 
always remembers the last playlist saved for each CD.  
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4.4.9 THE AUDIO RECORDER 
 
4.4.9.1 INTRODUCTION  
 

 
 
The Audio Recorder enables you to record, compress, store, and play back voice, 
music, and other sound. It provides settings for sound attributes such as 
mono/stereo, compression level, and sampling rate. You can use it to embed sound 
objects in documents created in applications that support object linking and 
embedding (OLE). 
 
The Audio Recorder’s edit, record, and playback capabilities are compatible with the 
Windows Sound Recorder and other recorders that record and play back in the PCM 
format. 
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4.4.9.2 THE AUDIO RECORDER CONTROLS 
 

 starts a new audio file.  inserts the Clipboard audio at the cursor or 
   replaces the selected portion. 
 

 opens an audio file.  mixes the Clipboard audio with the audio 
   beginning at the cursor. 
 

 saves an audio file.  starts recording. 
 

 reverses the last change you made to  plays the currently loaded audio file. 
 the current audio file. 
 

 removes the selected portion of the  stops the file currently playing or 
 audio file and stores it on the Clipboard.  recording. 
 

 copies the selected audio portion to the Clipboard without removing it. 
 

 
determines the cursor position on the 
waveform 

 
 
4.4.9.3 THE AUDIO RECORDER DISPLAY 
 

 
 
The four text boxes under the tool bar display the length in seconds of the selected 
part of the currently loaded file, the total length in seconds of the current file, 
whether the file is in stereo or mono, and the sampling rate in kilohertz. 
 
To the right of the text boxes is a box displaying the icon associated with the 
particular file. If a file has no icon associated with it, it is given a default icon. 
 



Software Installation 
 

83

  
 
The large area in the center of the window is the waveform display. It shows a 
graphic representation of the audio file currently in memory. The waveform is 
essentially a graph of the variation in air pressure over time that occurs when sound 
is produced, above the line (the line signifies one atmosphere) being a measurement 
of positive air pressure and below the line, negative. 
 
You control the display with the vertical and horizontal scroll bars: 
 
1. To zoom in on (magnify) the waveform, move the vertical scroll button down. 

To zoom out (minify), move the vertical scroll button up. 
  
2. displayed, click the right or left area of the horizontal scroll bar, respectively. 
  
3. To mark a portion of the audio file for playback, click at the beginning of the 

desired section, move the mouse while holding down the mouse button, and 
release the mouse button at the end of the desired section. Then click the Play 
button to hear the selected section. 

  
4. To deselect a selected portion of the waveform, click anywhere in the 

waveform display. 
  
5. To select the entire file, double-click anywhere in the waveform display. 
 

Note: Compressed files (.AUD files using ESPCM or ADPCM) cannot be 
displayed or edited. The waveform display is grayed out. 
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4.4.9.4 AUDIO RECORDER MEMU COMMANDS 
 
4.4.9.4.1 FILE MENU 
 

 
 
Properties opens the Properties dialog box, allowing you to view or change the 
properties of the current audio file. 
 
Exit closes the Audio Recorder window. 
 

New starts a new file by opening the Sound 
Attributes dialog box. 

Open brings up the Open file dialog box in 
order to load a file into the Audio Recorder. 

Save stores the current file to disk under its 
existing file name 

Save As  enables you to save a recorded file 
with a new name. 

Revert restores the file to its state when the 
file was last saved. 
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4.4.9.4.2 EDIT MENU 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Mute makes the selected portion of the file silent, reducing the amplitude of the 
selected portion of the waveform to zero. Use Undo immediately after muting to 
recover accidentally muted material. 
 
Select All selects the entire recording. 
 
Zoom In displays a smaller portion of the file in the waveform display. 
 
Zoom Out displays a larger portion of the file in the waveform display. 
 
Insert File opens the Insert File dialog box, enabling you to paste a file of your 
choice into the currently loaded file. 
 
Mix with File opens the Mix with File dialog box, enabling you to paste-mix a file 
of your choice into the currently loaded file. 

 

Undo reverses the last change you made to 
the current audio file. 
 
Cut removes the selected portion of the audio 
file and stores it on the Clipboard. 
 
Copy copies the selected portion of the audio 
file to the Clipboard without removing it. 
 
Paste inserts the audio stored on the 
Clipboard at the cursor or replaces a selection 
on the waveform display. 
 
Delete removes the selected portion of  the 
file.  The Del or Delete key on your keyboard 
also serves this function.  Use Undo 
immediately after deleting to recover 
accidentally deleted material. 
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Note: The Edit Menu is not available for compressed files. 

 
 
4.4.9.4.3 OPTIONS MENU 
 

 
 
 
 
4.4.9.4.4 EFFECTS MENU 
 

 
 

 
 
Speed changes the selected audio to be 100% faster or slower. 
 

 

Auto Repeat allows a loaded file to play endlessly 
when Play is clicked. 
 
Always On Top keeps the Audio Recorder on top of 
other windows on your desktop 

These commands alter the audio you have selected. If there is 
no selection, the entire file is affected. 
 
Normalize  amplifies the selected audio to the maximum 
volume possible without distortion.  
 
Volume increases or decreases the amplitude of the selected 
audio by 25% each time you apply it. 
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Fade causes the selected audio to Fade In from silence to its highest amplitude or 
Fade Out from its highest amplitude to silence. In other words, Fade In will have a 
three effects. First the leftmost portion of the selected audio will be silenced; zero 
amplitude. Second the rightmost portion of the selected audio will remain 
unchanged. Third, the audio in between will be ramped from left to right, from 
silence to the rightmost portion of the selected audio. Fade Out does the same 
thing except the selected audio is ramped down from the left to silence on the right. 
 

 
 
Echo displays the Echo Rate dialog box. Here you can set the echo delay in 
milliseconds and volume percentage for the selected audio. Essentially Echo copies 
and paste-mixes the selected audio into your selection. The Delay is how far to the 
right the duplicate is shifted. The Volume percentage is how loud the echo is in 
comparison to the original selection. 
 

 
 

Reverse rotates the selected audio horizontally, so the end becomes the beginning 
and the beginning the end. 
 

Note: The Effects Menu is not available for compressed files. 
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4.4.9.5 PLAYING A WAVE FILE 
 
First chose Open from the File menu or click the Open file button on the tool bar, 
bringing up the Open file dialog box. 
 

 
 
Choose the directory and the .WAV or .AUD file you wish to play and click OK. 
Now you can play the file by clicking the Play button. 
 

Note: If you wish to be sure the file can’t be changed in any way, select the Read 
only attribute. This attribute is temporarily assigned to the file. 
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4.4.9.6 RECORDING A WAVE FILE 
 
Start off by selecting New from the File menu or clicking the New file button on 
the tool bar to open the Sound Attributes dialog box. 
 

 
 
In the Sound Attributes dialog box, choose settings for the sampling rate, stereo on 
or off, and the format. Choose one of the PCM (uncompressed) formats if you want 
the highest sound quality or if you wish to edit or modify the recording with Effects 
commands before you save it. Use one of the other formats if you don’t mind 
sacrificing sound quality for disk space. When you are finished, click OK. 
 
Next, check your muting and recording volume levels on the Audio Mixer to be sure 
the sources you want to record from are active and at the proper levels. 
 
Now you are ready to record. Click the Record button and speak into the 
microphone or turn on whatever audio device(s) you are recording from. Click the 
Stop button to end recording. 
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4.4.9.7 SAVING A WAVE FILE 
 
When you are satisfied with your recording, select Save As  from the File menu or 
click on the Save file button on the tool bar. This opens the Save As Sound File 
dialog box. 
 

 
 
Enter the name of the file and choose the drive and directory where you wish to save 
it. You may wish to select the Read Only attribute to prevent accidental erasure or 
recording over of the file. The proper file type is displayed depending on the format 
of the file you are saving. If the file is uncompressed (you are using a PCM format) 
and you wish to compress it at this point, click Options and choose a compression 
algorithm. When you are done, click OK. 
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4.4.9.8 EDITING A WAVE FILE 
 
4.4.9.8.1 DELETING AN AUDIO SECTION 
 
1. With the mouse, select the portion of the audio data to be deleted. 
  
2. Press the Del key or choose the Delete command from the Edit menu. The 

selected audio disappears, joining the audio before and after it. If you wish to 
save the deleted section, use the Cut command instead of Delete. 

 
To restore a deleted audio section, choose the Undo command before making any 
other changes to the audio file. 
 
 
4.4.9.8.2 MUTING AN AUDIO SECTION 
 
1. Select the waveform of the audio to be muted. 
  
2. Choose Mute from the Edit menu. The selected audio is silenced; the 

waveform is reduced to a flat line. 
 
To restore a muted audio section, choose the Undo command before making any 
other changes to the audio file. 
 
 
4.4.9.8.3 MOVING OR COPYING AN AUDIO SECTION 
 
1. Select the portion of the audio data to be moved or copied. 
  
2. Click the Cut button to erase the selected audio and place it on the Clipboard, 

or click the Copy button to leave the selected audio as is while copying it to the 
Clipboard. 

  
3. Place the cursor where you want the Clipboard material to appear and click the 

Paste button. 
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4.4.9.8.4 RECORDING NEW AUDIO AND PLACING IT ON THE  
 CLIPBOARD 
 
1. Place the cursor at the end of the waveform display, or play the file to the end. 
  
2. With input source(s) ready, click the Record button to record new material. 

Click the Stop button to finish. 
  
3. Use the mouse to select the section just recorded, then click the Cut or Copy 

button to put that audio section onto the Clipboard. 
 
 
4.4.9.8.5 INSERTING AUDIO FROM THE CLIPBOARD 
 
1. Place the cursor at the point in the waveform display where you want to insert 

audio from the Clipboard. 
  
2. Click the Paste button. The Clipboard audio waveform appears at the cursor. No 

audio is erased. 
 
 
4.4.9.8.6 REPLACING THE SELECTED AUDIO WITH CLIPBOARD 
 AUDIO 
 
1. Use the mouse to select the waveform of the audio to be replaced. 
  
2. Click the Paste button. The Clipboard audio appears in place of the selected 

audio. 
 
 
4.4.9.8.7 MIXING CLIPBOARD AUDIO WITH THE SELECTED AUDIO 
 
1. Place the cursor at the beginning of the audio to be mixed, or select a section 

of audio to be mixed. 
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2. Click the Paste Mix button. The Clipboard audio is combined with the audio 
after the cursor. If a section of audio was selected, the Clipboard audio is 
combined with the selected audio until the end of either the Clipboard or 
selected audio. 

 
 
4.4.9.8.8 INSERTING AUDIO FROM ANOTHER FILE 
 
1. Place the cursor at the point in the waveform display where you want to insert 

an audio file, or select the audio you want to replace with an audio file. 
  
2. From the Edit menu, choose Insert File to display the Insert File dialog box. 

Then choose an audio file to insert into the current file. If audio is selected, the 
inserted audio file replaces the selected audio. 

  
3. Click OK. 
 

 
 



Chapter 4 
 
94

4.4.9.8.9 MIXING AUDIO FROM ANOTHER FILE 
 
1. Place the cursor at the beginning of the audio to be mixed. 
  
2. From the Edit menu, choose Mix with File to display the Mix With File dialog 

box. Then choose an audio file to combine with the current file, beginning at the 
cursor. 

  
3. Click OK. 
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4.4.9.8.10 CHANGING THE WAVEFORM WITH EFFECTS COMMANDS 
 
The Effects commands are described in this chapter in the section Audio Recorder 
Menu Commands— Effects Menu. The commands are: 
 
Normalize
: 

highest amplitude possible Fade: In or Out 

Volume: Increase or Descrease Echo: delay and intensity can be 
set 

Speed: Faster or Slower Reverse: reverses time axis of the 
recording 

 
   
4.4.9.9 ADDING SOUND TO A DOCUMENT: DRAG AND DROP 
 
The Audio Recorder's drag and drop feature enables you to embed audio files in 
documents. 
 
1. Open a document in the appropriate Windows application. 
  
2. Load an audio file from your disk to the Audio Recorder, or use an audio file 

you just recorded. 
  
3. Move the cursor to the icon at the top right of the Audio Recorder. The cursor 

changes into a hand. Click and hold down the mouse button, dragging the icon to 
the document window, then release the button at the place you want the audio 
icon to appear. 

  
4. To play an audio object in a document, double-click its icon. 
 
You can also add audio to a document from the document's application. Place the 
cursor where you want the audio icon to appear, choose the application's command 
for inserting an object, then select Audio Recorder in the list box. Refer to the 
section of the Windows User’s Guide for more information. 
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4.4.9.10 CHANGING AN AUDIO FILE'S PROPERTIES 
 

An audio file contains more than audio data. You can attach a title, 
description, and an icon to an audio file. To do so, choose Properties 
from the File menu. The Properties dialog box appears. 

 

  
 

In this dialog box, you can place the cursor in the Label or Description area 
to add or change the label or description for the audio file. Click Play to 
hear the audio file. 
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The Audio Recorder assigns a default picture of the AudioDrive logo to 
each audio file. To select your own icon for a given sound file, click Set 
Picture. The Set Picture dialog box appears. 
 

 
 

From here, select the picture to appear with the audio file. It can be any 
graphic contained in a bitmap (.BMP or .DIB), wave (.WAV), icon (.ICO), 
executable (.EXE), or library (.DLL) file. 
 
The picture you choose appears in the Audio Recorder. It also appears in 
any document in which you embed the audio file.changing wave file  
 
When you are finished, click OK. 
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4.5 XING MPEG PLAYER (OPTIONAL) 
 

Xing is a software MPEG player for the Video CD and MPEG format data. 
Please refers to the README.TXT file in the diskette for details about the 
installation. 
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CHAPTER 5   AWARD 
BIOS 

    
 SETUP GUIDE 

 
This following manual is specially provided for the BIOS supported system.  After 
the configuration of the mainboard, and have assembled the components, user can 
turn on the completed system.  At this point, run the software setup to ensure that 
the system information is correct. 
 
The software setup of the system board is achieved through Basic Input-Output 
System (BIOS) programming.  Use the BIOS setup program to tell the operating 
system what type of devices (such as disk drives) are connected to the system board. 
 
The system setup is also called CMOS setup.  Normally, users need to run system 
setup if either the hardware configuration is not identical with information 
contained in the CMOS RAM, or the CMOS RAM has lost power. 
 
 
5.1 AWARD BIOS SETUP 
 
 The setup program provided with the mainboard is the Award BIOS from 

Award Software, Inc.  Enter the AWARD Setup program's Main Menu as 
follows: 

 
 1. Turn on or reboot the system.  After a series of diagnostic check, 

the following message appear: 
 
 "Press DEL to enter SETUP" 
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 2. Press the <DEL> key to enter the AWARD BIOS setup program 
and the following screen appears: 

 
 ROM PCI/ISA BIOS (2A5IFG3A) 
 CMOS SETUP UTILITY 
 AWARD SOFTWARE, INC. 

 
  STANDARD CMOS SETUP 
 
  BIOS FEATURES SETUP 
 
  CHIPSET FEATURES SETUP 
 
  POWER MANAGEMENT SETUP 
 
  PNP/PCI CONFIGURATION 
 
  LOAD SETUP DEFAULTS 

   
  INTEGRATED PERIPHERALS 
 
  SUPERVISOR PASSWORD 
 
  USER PASSWORD 
 
  IDE HDD AUTO DETECTION 
 
  HDD LOW LEVEL FORMAT 
 
  SAVE & EXIT SETUP 
 
  EXIT WITHOUT SAVING 

  Esc : Quit    ?  ?  ?  ?  : Select Item 
  F10 : Save & Exit Setup   (Shift)F2 : Change Color 

 
 Time, Data, Hard Disk Type... 
 

 
 
 
 3. Choose an option and press <Enter>.  Modify the system 

parameters to reflect the options installed in the system. (see the 
following sections for more information). 

 
 4. Press <ESC> at anytime to return to the Main Menu. 
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 5. In the Main Menu, choose "SAVE AND EXIT SETUP" to save 
change and reboot the system.  Choosing "EXIT WITHOUT 
SAVING' to ignore all changes and exists the program. 

 
 
5.2 STANDARD CMOS SETUP 
 
 ROM PCI/ISA BIOS (2A5IFG3A) 
 STANDARD CMOS SETUP 
 AWARD SOFTWARE, INC. 

  Date (mm:dd:yy) : Thu, Jan 31 1991 
  Time (hh:mm:ss) : 15 : 23 : 15 
 
  HARD DISKS TYPE  SIZE  CYLS  HEAD  PRECOMP  LANDZ  SECTOR  MODE 
   
  Primary Master    : Auto 0         0         0             0             0           0   AUTO 
  Primary Slave      : None 0         0         0             0             0           0   -------- 
  Secondary Master : None 0         0         0             0             0           0   -------- 
  Secondary Slave   : None 0         0         0             0             0           0   -------- 
 

  Drive A : 1.44M , 3.5in. 
  Drive B : None 
 
  Video   : EGA/VGA 
  Halt On : All Errors 

   Base Memory:  640K 
        Extended Memory: 7168K 
             Other Memory:  384K 
        
             Total Memory: 8192K 
  

  Esc : Quit    ?  ?  ?  ?  : Select Item  PU/PD/+/- : Modify 
  F1  : Help    (Shift)F2 : Change Color 

 
 
 
  Date(mm/dd/yy) Type the current date. 
 
  Time(hh:mm:ss) Type the current time. 
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  Hard Disks  Choose from the standard hare disk 
types 1 to 45.  Type 47 is user 
definable.  Type Auto is for auto detect 
the hard disk type. 

 
  Drive A&B  Choose 360K, 5.25 in. 
      1.2M, 5.25 in. 
      720K, 3.5 in. 
      1.44M, 3.5 in. 
      2.88MB 3.5 in. or 
      None 
 
  Video   Choose EGA/VGA, 
      CGA 40, 
      CGA 80, or 
      MONO, 
 
  Halt On   Choose All Errors 
      No Errors, 
      All, But Keyboard, 
      All, But Diskette, or 
      All, But Disk/Key 
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5.3 BIOS FEATURES SETUP 
 
 ROM PCI/ISA BIOS (2A5IFG3A) 
 BIOS FEATURES SETUP 
 AWARD SOFTWARE, INC. 

Virus Warning 
CPU Internal Cache 
External Cache 
Quick Power On Self Test 
Boot Sequence 
Swap Floppy Drive 
Boot Up Floppy Seek 
Boot Up Numlock Status 
Boot Up System Speed 
Gate A20 Option 
Typematic Rate Setting 
Typematic Rate (Chars/Sec) 
Typematic Delay (Msec) 
Security Option 
PCI/VGA Palette Snoop 
Assign IRQ for VGA  
OS Select For DRAM > 64MB 

: Disabled 
: Enabled 
: Enabled 
: Disabled 
: A,C 
: Disabled 
: Enabled 
: On 
: High 
: Fast 
: Disabled 
: 6 
: 250 
: Setup 
: Disabled 
: Disabled 
: Non-OS2 

 Video BIOS Shadow 
 C8000-CBFFF Shadow 
 CC000-CFFFF Shadow 
 D0000-D3FFF Shadow 
 D4000-D7FFF Shadow 
 D8000-DBFFF Shadow 
 DC000-DFFFF Shadow 
 
 
 
 

: Enabled 
: Disabled 
: Disabled 
: Disabled 
: Disabled 
: Disabled 
: Disabled 

   ESC: Quit         ? ?? ??  ? : Select Item 
 F1: Help           PU/PD/+/-: Modify 
 F5: Old Values   (Shift)F2: Color 
 F7: Load Setup Defaults 

 
 BIOS Setup Defaults 
 
 
A short description of the screen items follows: 
 
Virus Warning: Enable Virus from invading the Boot area in either Hard Disk. 
 
CPU Internal Cache: Choose Enabled or Disabled.  This option lets user choose 
whether to use CPU internal cache memory.  The default is Enabled. 
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External Cache: Choose Enabled or Disabled.  This option lets user choose 
whether to use secondary cache memory.  The default is Enabled. 
 
Quick Power On Self Test: Choose Enabled or Disabled.  This option let the 
POST sequence runs longer for through tests. 
 
Boot Sequence: With the default setting the BIOS first attempts to boot from drive 
A: and then, if unsuccessful, from hard disk C:.  User can reverse this sequence with 
"C: A:", but then drive A: cannot boot directly. 
 
Swap Floppy Drive: Choose Enabled or Disabled.  This option lets end users to 
change the Drive A: or B: to others. 
 
Boot Up Floppy Seek: Choose Enabled or Disabled.  "Disabled" provides a fast 
boot and reduces the possibility of damage to the heads. 
 
Boot Up NumLock Status: Choose On or Off.  On puts numeric keypad in Num 
Lock mode at boot-up.  Off puts numeric keypad in arrow key mode at boot-up. 
 
Boot Up System Speed: Choose High or Low.  Set the CPU timing at Boot Up, the 
default is high. 
 
Gate A20 Option: Choose Fast or Slow.  The system switch back an forth from 
real mode to virtue mode, fast means the system will switch through logic, slow 
through keyboard.  The default is Fast. 
 
Typematic Rate Setting: Choose Enabled or Disabled.  Enabled will determines 
the typematic rate defined by following two options. 
 
Typematic Rate: The number selected 6,8,10... indicates how fast the number of 
characters can response in one second. 
 
Typematic Delay (Msec): The number selected indicates the time period between 
two identical keys appear. 
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Security Option: Choose Setup or System.  If system is selected, the password 
should be set. 
 
PCI/VGA Palette Snoop: Select Disabled or Enabled.  If Enabled the MPEG Card 
can synchronised with PCI/VGA. 
 
Assign IRQ for VGA:  Select Disabled or Enabled.  Disable this option will make 
the system BIOS not assign IRQ for the VGA card, so one more IRQ can be spare 
for another device. 
 
OS Select For DRAM > 64MB: Select Disabled or Enabled.  If the system 
memory is larger than 64MB and running OS/2, please enable this item.  However, 
if it use other operating system, please disable this feature.  Furthermore, if the 
system memory is less than 64MB, the BIOS will ignore this function. 
 
Video BIOS Shadow: ROM Shadow copies Video BIOS code from slower ROM to 
faster RAM.  Video BIOS can then execute from RAM. 
 
C8000-CFFFF Shadow: If enabled and BIOS is present in this segment, then the 
BIOS is shadowed. 
 
D0000-DFFFF Shadow: If enabled and BIOS is present in this segment, then the 
BIOS is shadowed. 
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5.4 CHIPSET FEATURES SETUP 
 
 The Advanced Chipset Setup option is used to change the values of the 

chipset registers.  These registers control most of the system options in the 
computer. 

 
 Note: Change these Settings only if user is familiar with the Chipset. 
 
 ROM PCI/ISA BIOS (2A5IFG3A) 
 CHIPSET FEATURES SETUP 
 AWARD SOFTWARE, INC. 

Auto Configuration 
 
SDRAM Leadoff Timing 
DRAM Leadoff Timing 
MDLE Delay Timing (ns) 
EDO CAS Pulse Width 
EDO CAS Precharge Time 
EDO MDLE Timing 
EDO BRDY# Timing 
EDO RAS Precharge Timing 
EDO RAMW# Power Saving 
ISA Bus Clock Frequency 
Slow Refresh (1:4) 
 
 
 
 

: Enabled 
 
: 3 Ck 
: 6 Ck 
: 5 
: R1 W2 Ck 
: 1 Ck 
: 1 Ck 
: 1 Ck 
: 3 Ck 
: Disabled 
: PCICLK/4 
: Enabled 

System BIOS Cacheable 
Video BIOS Cacheable 
Memory Hole at 15M-16M 
CPU-PCI Post Write Rate 
Latency for CPU-PCI 
CPU-PCI Burst Mem Write 
CPU-PCI Post Mem Write 
VGA Shared Memory Size 
VGA Memory Clock (MHz) 
Linear Mode SRAM Support 

: Enabled 
: Enabled 
: Disabled 
: 4 Ck 
: 1 Ck 
: Disabled 
: Enabled 
: 1 MB 
: 55 
: Disabled 

   ESC: Quit          ? ?? ??  ? : Select Item 
 F1: Help             PU/PD/+/-: Modify 
 F5: Old Values   (Shift)F2: Color 
 F7: Load Setup Defaults  
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A short description of the screen items follows: 
 
Auto Configuration: The default value of the following options in this menu will 
be different according to the CPU clock speed: 
 
 EDO CAS Pulse Width 
 EDO CAS Precharge Time 
 EDO RAS Precharge Timing 
 ISA Bus Clock Frequency 
 
To enable the "Auto Configuration" option will let the system BIOS to detect the 
CPU clock speed, and it will use the pre-defined value for these options according 
to speed detected, and the corresponding setting will be protected from making 
change.  It is strongly recommended to enable this option. 
 
SRAM Leadoff Timing: It is used to control the leadoff cycle of the asynchronous 
SRAM cache.  The available option is "3 Ck" and "4 Ck", and the default value is "3 
Ck". 
 
DRAM Leadoff Timing: It is used to control the leadoff cycle of the DRAM.  The 
available option "5 Ck" and "6 Ck", and the default option is "5 Ck".  
 
Asyn. SRAM Burst Tim.: It is used to control the burst cycle timing of the 
asynchronous SRAM type cache.  The option "2 Ck" and "3 Ck" should be set 
depending on the CPU clock speed, "2 Ck" is the optimum setting for this option 
over all range of CPU speed. 
 
Syn. SRAM Leadoff Tim.: It is used to control the leadoff cycle timing of the 
synchronous SRAM type cache.  The option are "3 Ck" and "4 Ck", and the optimum 
setting is "3 Ck".  
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EDO CAS Pulse Width, EDO CAS Precharge Time, EDO MDLE Timing, EDO 
BRDY# Timing, EDO RAS Precharge Timing: All of these options are used to 
control the EDO timing.  The default settings for these options are 
 

 Default Setting 

EDO CAS Precharge Time 1 Ck 

EDO MDLE Timing 1 Ck 

EDO BRDY# Timing 1 Ck 

 
The setting of "EDO CAS Pulse Width", "EDO CAS Precharge time", and "EDO RAS 
Precharge Timing" depend on the CPU clock speed, the followings are the optimum 
settings: 
 

CPU Speed EDO CAS 
Pulse Width 

EDO CAS 
Precharge Time 

EDO RAS 
Precharge Timing 

75MHz R1 W2 Ck 1 Ck 3 Ck 

90MHz or above R1 W2 Ck 2 Ck 4 Ck 

 
EDO RAMW# Power Saving: It is used to enable or disable the power saving 
mode when the EDO bank is being accessed. 
 
ISA Bus Clock Frequency: It is used to select the bus clock for the ISA bus.  The 
available options are "7.159MHz", "CPUCLK/4" and "CPUCLK/3".  
 

CPU Speed ISA Bus Clock Frequency 

 75MHz CPUCLK/3 

 Other than 75MHz CPUCLK/4 
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Slow Refresh (1:4): To enable this function will allow the DRAM refresh in a 
slower rate. 
 
Video BIOS Cacheable: It is used to enable or disable the Video BIOS being 
cacheable. 
 
Memory Hole At 15M-16M: To enable this function will allow the VGA 
controller to rung larger frame port. 
 
CPU-PCI Post Write Rate: This option is used to control the timing of the CPU 
to PCI Post Write buffer.  The available option is "3 Ck" and "4 Ck", and the default 
value is "4 Ck". 
 
VGA Share Memory Size: If external VGA card is installed, this option will not be 
shown.  It is used to select the video ram size shared with the system memory, the 
available options are "0.5MB", "1MB", "1.5MB" and "2MB". 
 
VGA Memory Clock (MHz): If external VGA card is installed, this option will not 
be shown.  It is used to select the VGA memory clock frequency of the on-board 
graphics controller used.  The available frequency ranges from 40MHz to 70MHz.  
The default value is 55MHz. 
 
Linear Mode SRAM Support:  This option is shown only when Cyrix 6x86 is 
used.  If Cyrix 6x86 is installed, this option is recommended as "Enabled" and JP7 
should be shorted. 
 
Latency for CPU-PCI: It is used to control the latency of the CPU to PCI cycle.  
The available optionis "1 Ck" and "2 Ck", and the default value is "2 Ck".  
 
CPU-PCI Burst Menu Write: It is used to enable or disable the CPU to PCI Burst 
Memory Write. 
 
CPU-PCI Post Memu Write: It is used to enable or disable the CPU-PCI Post 
Memory Write. 
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5.5 POWER MANAGEMENT SETUP MENU 
 
 The Power Management Setup option is used to change the values of the 

chipset registers for system power management functions. 
 
 
 ROM PCI/ISA BIOS (2A5IFG3A) 
 POWER MANAGEMENT SETUP 
 AWARD SOFTWARE, INC. 

Power Management 
PM Control by APM 
Video Off Option 
Video off Mehtod 
Suspend Switch 
MODEM Use IRQ 
 
  **PM Timers** 
HDD Off After 
Suspend Mode 
 
  **PM Events** 
COM Ports Activity 
LPT Ports Activity 
HDD Ports Activity 
PCI/ISA Master Act. 
IRQ1-15 Activity 

: User Define 
: Yes 
: Suspend- >Off 
: V/H SYNC+Blank 
: Enabled 
: 3 
 
 
: Disabled 
: Disabled 
 
 
: Enabled 
: Enabled 
: Enabled 
: Enabled 
: Enabled 

 VGA Activity 
 IRQ3  (COM 2) 
 IRQ4  (COM 1) 
 IRQ5  (LPT 2) 
 IRQ6  (Floppy Disk) 
 IRQ7  (LPT 1) 
 IRQ8  (RTC Alarm) 
 IRQ9  (IRQ2 Redir) 
 IRQ10 (Reserved) 
 IRQ11 (Reserved) 
 IRQ12 (PS/2 Mouse) 
 IRQ13 (Coprocessor) 
 IRQ14 (Hard Disk) 
 IRQ15 (Reserved) 

: Enabled 
: Enabled 
: Enabled 
: Enabled 
: Enabled 
: Enabled 
: Disabled 
: Enabled 
: Enabled 
: Enabled 
: Enabled 
: Enabled 
: Enabled 
: Enabled 
 

   ESC: Quit           ? ?? ??  ? : Select Item 
 F1: Help              PU/PD/+/-: Modify 
 F5: Old Values    (Shift)F2: Color 
 F7: Load Setup Defaults  
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A short description of the screen items follows: 
 
Power Management: Available selection are "Disabled", "User Define", "Max 
Saving" and "Min Saving": 
"Disabled" will disable all the power saving functions. 
"User Define" makes the time period waiting for Suspend Mode to be programmed. 
"Max Saving" will set the time period waiting for Suspend Mode to be 20 seconds. 
"Min Saving" will set the time period waiting for Suspend Mode to be 40 minutes. 
 
PM Control by APM: Available options are "Yes" and "No".  To choose "Yes" to let 
the Power Management Function to be control by the MS APM software. 
 
Video Off Option: Available options are "Suspend->Off" and "Always On".  To 
choose "Suspend->Off" option will make the video off during the Suspend Mode.  
"Always On" will keep the video on for all the modes. 
 
Video Off Method: Choose V/H SYNC+Blank, DPMS or Blank Screen.  This is 
monitor Power Saving Method.  V/H SYNC+Blank means turn off Vertical, 
Horizontal scanning and blank the screen.  Blank Screen will blank the display 
screen.  DPMS (Display Power Management System) can allow the System BIOS 
control the Display Card to turn off the Display. 
 
Suspend Switch: It is used to enable or disable the function of the Green PC Break 
Switch - JP12. 
 
MODEM Use IRQ: Available options are 3, 4, 5, 7, 9, 10, 11 and NA.  It is used to 
choose the interrupt line that the Modem is used.  “NA” means not available. 
 
HDD Off After: To select the time period will turn the HDD off.  Accessing the 
HDD again will take a few seconds for HDD to spin up for operation. 
 
Suspend Mode: To set the time period waiting for Suspend Mode when the Power 
Management function is set to "User Define".  
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COM Ports Activity/LPT Ports Activity/HDD Ports Activity/PCI/ISA Master 
Act./IRQ1-15 Activity/VGA Activity: All of these functions are used to control 
the wake up event from the Suspend Mode.  Once the function is enabled, the 
corresponded activity will trigger the system back to the Normal Mode from the 
Suspend Mode. 
 
IRQ 3 - IRQ15: When it is enabled, the system will monitor the activity of the 
corresponded system IRQ to turn on or off the power management functions. 
 
 
5.6 PnP/PCI CONFIGURATION 
 
 The PCI Configuration Setup option is used to configure the PCI add-on 

Cards on PCI Slots.  Without proper setup the PCI Add-on Cards might not 
function properly. 

 
 ROM PCI/ISA BIOS (2A5IFG3A) 
 PNP/PCI CONFIGURATION 
 AWARD SOFTWARE, INC. 

 PNP OS Installed 
 Resources Controlled By 
 Reset Configuration Data 
 
 IRQ-3  assigned to 
 IRQ-4  assigned to 
 IRQ-5  assigned to 
 IRQ-7  assigned to 
 IRQ-9  assigned to 
 IRQ-10 assigned to 
 IRQ-11 assigned to 
 IRQ-12 assigned to 
 IRQ-14 assigned to 
 IRQ-15 assigned to 

: Yes 
: Manual 
: Disabled 
 
: Legacy ISA 
: Legacy ISA 
: Legacy ISA 
: Legacy ISA 
: PCI/ISA PnP 
: PCI/ISA PnP 
: PCI/ISA PnP 
: PCI/ISA PnP 
: Legacy ISA 
: Legacy ISA 

 PCI IRQ Actived By 
 PCI IDE 2nd Channel  
 PCI IDE IRQ Map To 
  Primary IDE INT# 
  Secondary IDE INT# 
 PCI Spec. Ver 2.1 
 
 
 
 
 
 
 

: Level 
: Enabled 
: PCI-AUTO 
: A 
: B 
: Enabled 
 
 

 DMA-0  assigned to 
 DMA-1  assigned to 
 DMA-3  assigned to 
 DMA-5  assigned to 
 DMA-6  assigned to 
 DMA-7  assigned to 

: PCI/ISA PnP 
: PCI/ISA PnP 
: PCI/ISA PnP 
: PCI/ISA PnP 
: PCI/ISA PnP 
: PCI/ISA PnP 

 ESC: Quit        ? ? ?  ? : Select Item 
 F1: Help          PU/PD/+/-: Modify 
 F5: Old Values  (Shift)F2: Color 
 F7: Load Setup Defaults  
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 Note: Change these Settings only if user is familiar with the Chipset and all the PCI 
 Add-on Cards functions. 
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A short description of the screen items follows: 
 
PNP OS Installed: Choose “Yes” to configure the BIOS that the Operating System 
installed support the Plug and Play standard. 
 
Resources Controlled By: Available options are "Manual" and "Auto".  If "Auto" is 
selected, the system BIOS will use the ESCD with the legacy information.  If 
"Manual" is selected, the BIOS will not refer the ESCD for IRQ and DMA 
information.  Instead, it will refer the items in the items in this setup menu for 
assigning IRQ and DMA. 
 
Reset Configuration Data: If enable this option, the BIOS will clear and reset the 
ESCD after hardware reset. 
 
IRQ#/DMA# assigned to: These items will be shown only when "Resources 
Controlled By" option is set the "Manual".  The available options are "Legacy ISA: 
and "PCI/ISA PnP".  If the option is set to "Legacy ISA", the BIOS will never assign 
the specified IRQ/DMA resource to PCI or ISA PnP Devices.  If "PCI/ISA PnP" is 
chosen, the BIOS will make the specified IRQ/DMA have a chance to be assigned to 
the PCI or ISA PnP devices. 
 
PCI IRQ Active By: Choose Level or Edge.  The default settings is Level. 
 
PCI IDE IRQ Map To: Choose PCI-AUTO, PCI-SLOT1, PCI-SLOT2, PCI-SLOT3, 
ISA.  The default setting is PCI-AUTO. 
 
PCI Spec. Ver 2.1: Choose Enabled or Disabled.  To enable this option will make 
the PCI cycle following the PCI Speicification Version 2.1. 
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5.7 LOAD SETUP DEFAULTS MENU 
 
 This Main Menu item uses the default setup values.  Use this option as a 

diagnostic aid if the system behaves erratically.  Choose this item and the 
following message appears: 

 
 "Load SETUP Defaults (Y/N)? N" 
 
 To use the Power-On defaults, change the prompt to "Y" and press <Enter>. 
 
 
5.8 INTEGRATED PERIPHERALS SETUP MENU 
 
 The Integrated Peripherals setup option is need to change the values of the 

I/O chipset registers for I/O functions. 
 
 ROM PCI/ISA BIOS (2A5IFG3A) 
 INTEGRATED PERIPHERALS 
 AWARD SOFTWARE, INC. 

 Internal PCI/IDE 
 IDE Primary Master PIO 
 IDE Primary Slave PIO 
 IDE Secondary Master PIO 
 IDE Secondary Slave PIO 
 Primary IDE Prefetch 
 Secondary IDE Prefetch 
 IDE Burst Mode 
 IDE Post Write 
 IDE HDD Block Mode 
 
 Onboard FDD Controller 
 Onboard Serial Port 1 

: Both 
: Auto 
: Auto 
: Auto 
: Auto 
: Both 
: Both 
: Disabled 
: Enabled 
: Enabled 
 
: Enabled 
: Auto 

 
 
 
 
 

 Onboard Serial Port 2 
 UART 2 Mode 
 
 Onboard Parallel Port 
 Onboard Parallel Mode 
 ECP Mode Use DMA 
 

: Auto 
: Standard 
 
: 378/IRQ7 
: ECP 
: 3 
 

 ESC: Quit        ? ? ?  ? : Select Item 
 F1: Help          PU/PD/+/-: Modify 
 F5: Old Values  (Shift)F2: Color 
 F7: Load Setup Defaults  
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A short description of the screen items follows: 
 
Internal PCI/IDE: Available selection are "Disabled", "Primary", "Secondary", 
"Both". 
It is used to configure the built in PCI IDE controller. 
"Disabled" will disable the internal PCI IDE controller. 
"Primary" will configure the internal PCI IDE controller to enable the primary 
channel only. 
"Secondary" will configure the internal PCI IDE controller to enable the secondary 
channel only. 
"Both" will configure the internal PCI IDE controller to enable both the primary and 
secondary channels. 
 
IDE Primary Master PIO/IDE Primary Slave PIO/IDE Secondary Master 
PIO/IDE Secondary Slave PIO: Available selection are "Auto", "Mode 0", "Mode 
1", "Mode 2", "Mode 3" and "Mode 4".  To choose "Auto", the system BIOS will scan 
the IDE device and decide which mode of the device is.  Otherwise the user should 
key in the mode of the device to the corresponding field. 
 
Primary IDE Prefetch/Secondary IDE Prefetch: It is used to enable or disable 
the prefetch buffer of the corresponding IDE channel. 
 
IDE Burst Mode: It is used to enable or disable the IDE burst mode. 
 
IDE Post Write: It is used to enabled or disabled the IDE post write buffer. 
 
IDE HDD Block Mode: It is used to enable or disable the IDE harddisk block 
mode. 
 
Onboard FDD Controller: It is used to enable or disable the on board floppy disk 
controller. 
 
Onboard Serial Port 1: Available options are “Auto”, “COM4/2E8”, 
“COM3/3E8”, “COM1/3F8” and “Disabled”.  It is used to configure the on board 
serial port 1 to different port address or disable it.  Make proper selection to avoid 
address conflict with other I/O devices. 
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Onboard Serial Port 2: Available options are “Auto”, “COM3/3E8”, 
“COM4/2E8”, “COM2/2F8” and “Disabled”.  It is used to configure the on board 
serial port 1 to different port address or disable it.  Make proper selection to avoid 
address conflict with other I/O devices. 
 
UART 2 Mode: It is used to select the operating mode of on board serial port 2.  
Choose Standard for RS232 serial Interface; ASKIR and HIPSIR for IrDA serial 
Interface. 
 
IR Function Duplex: This item will be shown only when UART 2 Mode is 
selected to ASKIR or HPSIR.  The available options are “Full” and “Half”.  It is used 
to choose the IR function working in full duplex mode or half duplex mode 
correspondingly. 
 
RxD, TxD Active: This item will be shown only when UART 2 Mode is selected to 
ASKIR or HPSIR.  The available options are “Hi, Hi”, “Hi, Lo”, “Lo, Hi” and “Lo, 
Lo”.  It is used to configure the logic level of Receive and Transmit  signal in IrDA 
interface. 
 
Onboard Parallel Port: Available options are "3BCH/IRQ7", "278/IRQ5", 
"378H/IRQ7" and "Disabled".  It is used to configure the on board parallel port to 
different port address and IRQ or disable it.  Make proper selection to avoid address 
and IRQ conflict with other I/O devices. 
 
Onboard Parallel Mode: Available options are “SPP”, “EPP/SPP”, “ECP” and 
“ECP/EPP”.  It is used to configure the on board parallel port to "Standard Printer 
Port Mode", "Enable Parallel Mode" or "Extended Capabilities Port Mode.  Make 
proper selection with the attached printer port device. 
 
ECP Mode Use DMA:  Choose “1” or “3” to select the DMA channel used for the 
ECP device.  This item is shown if the Onboard Parallel Mode is chosen as “ECP” 
or  “ECP/EPP” option. 
 
Parallel Port EPP Type: Choose “EPP1.7” or “EPP1.9”, which is used to 
configure the EPP using either EPP1.7 or 1.9 timing specification.  This item is 
shown if the Parallel Mode  is chosen as “EPP” or “ECP/EPP” option. 
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5.9 SUPERVISOR PASSWORD 
 
 Two level of password is supported.  Depending on the setting of the 

"Security Option" in the "BIOS FEATURES SETUP", the system BIOS will 
ask for password every time booting up the System or entering BIOS Setup. 
With the supervisor password, both the system booting and BIOS setup 
changing is allowed. 

 
 This main menu item lets the user to set up the Supervisor Password. 
 Change the password as follows: 
 
 1. Choose "PASSWORD SETTING" in the Main Menu and press 

<Enter>.  The following message appears: 
 
 "ENTER PASSWORD:" 
 
 2. Enter the Password and press <Enter>.  The following 

message appears: 
 
 "CONFIRM PASSWORD:" 
 
 Important: Keep a safe record of the new password.  If forget or 

lose the password, the only way to access the system is 
to disconnect the CMOS batteries and then re-enter the 
password. 

 
 
5.10 USER PASSWORD 
 
 With the user password, only booting up the system is accepted, but 

changing the BIOS setup is not allowed. 
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5.11 IDE HDD AUTO DETECTION 
 
 When users can not find the Hard Disk information, it is very helpful to use 

this option. 
 
 1. Choose this item and press <Enter>. 
 
 2. After couple seconds, the screen will appear the Hard Disk 

information and following message: 
 
 "SELECT PRIMARY MASTER OPTION(N=SKIP): N" 
 
 3. Enter Y or N to confirm the acceptance then enter. 
 
 4. The process will repeat for Primary Slave, Secondary Master and 

Secondary Slave Hard Disks. 
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5.12 HDD LOW LEVEL FORMAT MENU 
 
 Three utilities are provided in the HDD Low Level Format menu: 
 
 (1) SELECT DRIVE 
 (2) BAD TRACK LIST 
 (3) PREFORMAT 
 

Hard Disk Low Level Format Utility BAD TRACKS TABLE 
 NO. CYLS HEAD 

  
         
  SELECT DRIVE     
  BAD TRACK LIST     
  PREFORMAT     

         
         
         
         
         

Current select drive is : C   
         

DRIVE: C CYLINDER : 0 HEAD : 0   
  SIZE CYLS HEAD PRECOMP LANDZ SECTOR MODE 

Primary Master: 270 944 14 65535 943 40 NORMAL 

Primary Slave: 0 0 0 0 0 0 NORMAL 

Secondary Master: 0 0 0 0 0 0 NORMAL 

Secondary Slave: 0 0 0 0 0 0 NORMAL 

Up/Down-Select item  ENTER-Accept  ESC-Exit/Abort 

Copyright (c) Award Software, Inc. 1992-94 All Rights Reserved 

 
 Setup Screen shown when "SELECT DRIVE" option is selected 
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Hard Disk Low Level Format Utility BAD TRACKS TABLE 
 NO. CYLS HEAD 

  
         
  SELECT DRIVE     
  BAD TRACK LIST     
  PREFORMAT     

         
         

Auto scan bad track   
add bad track   

Modify bad track   
Delete bad track   

Clear bad track table   
DRIVE: C CYLINDER : 0 HEAD : 0   

  SIZE CYLS HEAD PRECOMP LANDZ SECTOR MODE 

Primary Master: 270 944 14 65535 943 40 NORMAL 

Primary Slave: 0 0 0 0 0 0 NORMAL 

Secondary Master: 0 0 0 0 0 0 NORMAL 

Secondary Slave: 0 0 0 0 0 0 NORMAL 

Up/Down-Select item  ENTER-Accept  ESC-Exit/Abort 

Copyright (c) Award Software, Inc. 1992-94 All Rights Reserved 

 
 Setup Screen shown when "BAD TRACK LIST" option is selected 
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Hard Disk Low Level Format Utility BAD TRACKS TABLE 
 NO. CYLS HEAD 

  
         
  SELECT DRIVE     
  BAD TRACK LIST     
  PREFORMAT     

         
         
         

Interleave (1-8) : 0 (0 for auto detect)   
Auto scan bad track : N   

START : N   
         

DRIVE: C CYLINDER : 0 HEAD : 0   
  SIZE CYLS HEAD PRECOMP LANDZ SECTOR MODE 

Primary Master: 270 944 14 65535 943 40 NORMAL 

Primary Slave: 0 0 0 0 0 0 NORMAL 

Secondary Master: 0 0 0 0 0 0 NORMAL 

Secondary Slave: 0 0 0 0 0 0 NORMAL 

Up/Down-Select item  ENTER-Accept  ESC-Exit/Abort 

Copyright (c) Award Software, Inc. 1992-94 All Rights Reserved 

 
 Setup Screen shown when "PREFORMAT" option is selected 
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5.13 SCSI HARD DISK INSTALLATION 
 

In Standard CMOS Setup Utility, select hard disk type to be "Not Installed".  
In Advanced CMOS Setup Utility, Disable "Adapter ROM Shadow DC00".  
On the SCSI Controller card, set the jumpers which configure the SCSI 
card BIOS segment address located at DC00 or DE00.  Format the SCSI 
disk by the Formatter provided in the SCSI BIOS. 

 
 
5.14 SAVE & EXIT SETUP MENU 
 

When you select this function, the following message will appear at the 
centre of the screen to assist you to Save data to CMOS and Exit the Setup. 

 
 Save to CMOS and Exit (Y/N)? 
 
 
5.15 EXIT WITHOUT SAVING MENU 
 

When you select this function, the following message will appear at the 
centre of the screen to assist you to Abandon all Data and Exit Setup. 

 
 Quit Without Saving (Y/N)? 
 
 


